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Team Support

Enterprise Architect has been built from the ground up as a
team modeling platform, and has extensive support for
groups of people working together on the same projects,
sharing information, ideas and models. The team support
includes features ranging from Baselines, Version Control
and a Reusable Asset Service that protect the valuable
modeling assets in a team environment, to collaborative
tools such as a Discussion Forum, Team Library and Gantt
Charts to facilitate people working together. The role-based
security system has been designed to encourage
collaboration, allowing team members to work together
without the fear of interfering with each other’s work.

There is a wide range of deployment options that will suit
any team development environment, allowing people to
work centrally or remotely in highly distributed
environments. Corporate policy and standards can also be
built into the models with the use of Workflow Scripts. A
free 'Lite' version of Enterprise Architect is available for
team members who simply want to view the models, and
high quality corporate documentation can be generated in a
wide number of formats to communicate with people
outside the modeling platform.
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Overview

Facility Description

Team
Development

Setup a collaborative modeling
environment, taking advantage of
security, workflow and shared reference
data, as discussed in this topic.

Formal
Model

Reviews

A simple yet powerful mechanism for
capturing, in real time, reviews of a
section of the model in line with a
particular event. Typically, a Project
Manager or other coordinator will create
a Review element specifically to discuss
one or more elements for a project phase,
project stage or other category of review,
over a defined period.

Project
Management

Explore some of the ways you can
manage your project and team within
Enterprise Architect.

Project
Resources

Track and manage the people and
resources in your project.
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Glossary Define a common vocabulary between
your different teams, ensuring everyone
is on the same page.

Task
Allocation

Assign and Track your team's tasks in a
Gantt View.

Personal
Tasks

Record and manage your personal work
within the project.

Model Mail Securely communicate with your team in
an email style embedded within
Enterprise Architect, via Model Mail.

Project
Calendar

Track the deployment of resources,
timeframes for tasks, and upcoming
project events such as meetings and
milestones, in a calendar format.

Use Case
Estimation

Form an estimate of the complexity of a
system and an indication of the effort
required to implement the model.

Team Library A team based library of documents to
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record and discuss the development and
progress of the project.

Making project data available in a
distributed environment

Enterprise Architect offers a diverse set of functionality
designed specifically for sharing projects in team-based and
distributed development environments; for example:
Cloud-based solutions, network deployment of model
repositories, replication and XMI Import/Export.

Applying security to the model

User Security is a means of improving collaborative design
and development by preventing concurrent editing, and
limiting the possibility of inadvertent model changes by
users not designated as model authors.

Using an internal discussion forum

The Discussions facility provides several mechanisms to
support your development team community in discussing
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specific elements in the model as a component of each
element or, more generally, the development and progress of
the model across the project.

Building company policy and project
development guidelines into the project

You can create workflow scripts that provide a robust
approach to applying company policy and strengthening
project development guidelines, by validating against the
policy and procedures within the model itself.

Standardizing and re-using project data

You can import and export Reference data (including
Glossary and Issue information) from .XML files of another
iteration of the same model, or of a different model.
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Project Roles

Enterprise Architect is a powerful multi-disciplinary
modeling platform that supports common work practices
and provides features to assist the entire spectrum of roles
and disciplines across enterprise, business, engineering and
software projects. Each role will typically use different
features of the tool. A number of the roles and their
responsibilities that the system supports are outlined here.

You can review a summary of the typical tasks supported
for each role, or click on the appropriate role title to explore
how Enterprise Architect can assist you in carrying out that
role within a model-driven project.

Roles and Responsibilities

Role Responsibilities

Business
Analyst

Create high-level models of business
processes.

Software
Architect

Map functional requirements, perform
real time modeling of objects, design the
Deployment model and detail the
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deliverable components.

Software
Engineer

Map Use Cases onto Class diagrams,
detail the interactions between Classes,
define the system deployment and define
software Packages.

Developer Perform round trip code engineering,
including reverse engineering of existing
code and generation of code from Class
elements.

Project
Manager

Assign resources to elements, measure
risk and effort, estimate project sizes, and
manage element status, change control
and maintenance.

Tester Create test scripts against elements in the
modeling environment.

Implementati
on Manager

Track and assign maintenance-related·

items to elements within Enterprise
Architect
Rapidly capture and keep records of·

maintenance tasks such as issues,
changes, defects and tasks
Trace the maintenance of the items and·

processes involved in system
deployment

(c) Sparx Systems 2018 Page  12 of 260



User Guide - Team Support 21 December, 2018

Technology
Developer

Create customized additions to the
functionality already present within
Enterprise Architect.

Database
Developer

Develop databases, including modeling
database structures, importing database
structures from an existing database and
generating DDL for rapidly creating
databases from a model.
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Summary of Typical Tasks

Throughout a design and development project there are
many different tasks to be performed, which could be
carried out either by one person or - more probably - by
members of a team with different responsibilities. In either
case, Enterprise Architect supports most - if not all - of the
responsibilities you might have on your project. The
descriptions in this topic identify a number of job roles that
the system supports. For those that most resemble your role
on a project, click on the job title hyperlink to display a
description of how that role might make use of Enterprise
Architect, then click on links within those topics to explore
some of the features of importance to the role.

Summary of Typical Job Roles

Most of these roles work with specific types of diagram, so
you might want to learn more about diagram types in
general and specific types of diagram in particular.

Several types of project team member might want to
generate documentation on their work and report on how the
project is developing and changing. Using Enterprise
Architect you can generate project reports in either
document or web format.

Role Responsibilities
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Business
Analyst

For modeling:
Requirements·

High-level business processes·

Business activities·

Work flows·

System behavior·

Database
Developer

Developing databases·

Modeling database structures·

Creating logical data models·

Generating schema·

Reverse engineering databases·

Software
Architect

Mapping functional requirements of the·

system
Mapping objects in real time·

Mapping the deployment of objects·

Defining deliverable components·

Tester Developing test cases·

Importing requirements, constraints·

and scenarios
Creating Quality Test documentation·

Tracking element defects and changes·

Software
Engineer

Mapping Use Cases into detailed·

Classes
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Defining the interaction between·

Classes
Defining system deployment·

Defining software Packages and the·

software architecture

Project
Manager

Providing project estimates·

Resource Management·

Risk Management·

Maintenance Management·

Developer Forward, reverse and round-trip·

engineering
Visualizing the system states·

Visualizing Package arrangements·

Mapping the flow of code·

Implementati
on Manager

Modeling the tasks in rolling-out a·

project, including network and
hardware deployment
Assigning and tracking maintenance·

items on elements (issues, changes,
defects and tasks)

Technology
Developer

For creating or customizing:
UML Profiles·

Patterns·
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Code Templates·

Tagged Value Types·

MDG Technologies·

Add-Ins·

Notes

The Corporate, Unified and Ultimate editions of·

Enterprise Architect have a user security feature that can
be applied or turned off; if security is turned on, you need
to have the appropriate access permissions to use many of
the facilities
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Business Analysts

A Business Analyst can use Enterprise Architect to create
high-level models of business processes, including business
requirements, activities, workflow, and the display of
system behavior.

Using Enterprise Architect, a Business Analyst can describe
the procedures that govern what a particular business does.
Such a model is intended to deliver a high-level overview of
a proposed system.

Business Analyst Tasks

Task Detail

Model High
Level
Business
Processes

Using Analysis diagrams, you can model
the high-level processes of the business.
Analysis diagrams are a subset of UML
2.5 Activity diagrams and are less formal
than other diagram types, but they
provide a useful means for expressing
essential business characteristics and
requirements.

Model
Requirements

Gathering requirements is typically the
first step in developing a solution, be it
for developing a software application or
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for detailing a business process; it is an
important step in the implementation of a
project.
Using Enterprise Architect, you can
define the Requirement elements, connect
Requirements to the model elements for
implementation, connect Requirements
together into a hierarchy, report on
Requirements, and move Requirements
out of model element responsibilities.

Model
Business
Activities

You can use Activity diagrams to model
the behavior of a system and the way in
which these behaviors are related to the
overall flow of the system.
Activity diagrams do not model the exact
internal behavior of the system but show
instead the general processes and
pathways at a high level.

Model
Workflow

To visualize the cooperation between
elements involved in the workflow, you
can use an Interaction Overview diagram,
which provides an overview of sub
activities that are involved in a system.

Display
System
Behavior

In displaying the behavior of a system as
a Use Case diagram, Enterprise Architect
provides an easily understood tool for
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mapping the functional requirements and
behavior of a system.
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Software Architects

Software Architects can use Enterprise Architect to map
functional requirements with Use Cases, perform real time
modeling of objects using Interaction diagrams (Sequence,
Timing, Communication or Interaction Overview), design
the Deployment model and detail the deliverable
components using Component diagrams.

Software Architect Tasks

Task Detail

Map
Functional
Requirements
of the System

With Enterprise Architect you can take
the high level business processes that
have been modeled by the Business
Analyst and create detailed Use Cases.
Use Cases describe the proposed
functionality of a system and are only
used to detail a single unit of discrete
work.

Map Objects
in Real Time

You can use Interaction diagrams
(Sequence and Communication diagrams)
to model the dynamic design of the
system.
Sequence diagrams detail the messages
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that are passed between objects, and the
lifetimes of the objects.
Communication diagrams are similar to
Sequence diagrams, but instead display
the way in which the object interacts with
other objects.

Map
Deployment
of Objects

You can use Deployment diagrams to
provide a static view of the run-time
configuration of processing nodes and the
components that run on the nodes.
Deployment diagrams show the
connections between hardware, software
and any middleware that is used on a
system.

Detail
Deliverable
Components

Using Component diagrams, you can
model the physical aspects of a system.
Components can be executables, libraries,
data files or another physical resource
that is part of a system.
The component model can be developed
from scratch from the Class model or can
be brought in from existing projects and
from third-party vendors.
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Software Engineers

Software Engineers using Enterprise Architect can manually
map Use Cases onto Class diagrams, detail the interactions
between Classes, define the system deployment with
Deployment diagrams and define software Packages with
Package diagrams.

Software Engineering Tasks

Task Detail

Map Use
Cases into
Detailed
Classes

Within Enterprise Architect you can
study the Use Cases developed by the
Software Architect, and with that
information create Classes that fulfill the
objectives defined in the Use Cases.
A Class is one of the standard UML
constructs that is used to detail the pattern
from which objects are produced at run
time; to record the relationships between
Use Cases and Classes, you can create
diagrams linking the elements with
Realization connectors, and/or map the
Realization connectors in the
Relationship Matrix.
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Detail
Interaction
Between
Classes

You can use Interaction diagrams
(Sequence and Communication diagrams)
to model the dynamic design of the
system.
Sequence diagrams are used to detail the
messages passed between objects, and the
lifetimes of the objects.
Communication diagrams are similar to
Sequence diagrams, but instead display
the way in which objects interact with
other objects.

Define
System
Deployment

Deployment diagrams provide a static
view of the run-time configuration of
processing nodes and the components
that run on the nodes.
Deployment diagrams can be used to
show the connections between hardware,
software and any middleware that is used
on a system, to explain the connections
and relationships of the components.

Define
Software
Packages

You can use Package diagrams to detail
the software architecture.
Package diagrams are used to organize
diagrams and elements into manageable
groups, declaring the dependencies.
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Simple Use Case diagram
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Developers

Developers can use Enterprise Architect to perform round
trip code engineering, which includes reverse engineering of
existing code and generation of code from Class elements.

Developer Tasks

Task Detail

Round Trip
Engineering

Enterprise Architect gives you
unparalleled flexibility in 'round tripping'
software from existing source code to
UML 2.5 models and back again.
Round trip engineering involves both
forward and reverse engineering of code,
keeping the model and code
synchronized.

Reverse
Engineering

In Enterprise Architect, you can reverse
engineer code from a number of
supported languages and view the
existing code as Class diagrams, which
illustrate the static design view of the
system.
Class diagrams show Classes and
interfaces, and the relationships between
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them; the Classes defined in UML Class
diagrams can have direct counterparts in
the implementation of a programming
language.

Forward
Engineering

As well reverse engineering your code
into your model, you can forward
engineer elements of your model into
code (code generation).
This way you can make changes to your
model with Enterprise Architect and
quickly implement the changes in the
source code.

Determine
the System
State

To visualize the state of the system you
can use StateMachine diagrams to
describe how elements move between
States, classifying their behavior
according to transition triggers and
constraining guards.
StateMachine diagrams capture system
changes over time, typically being
associated with particular Classes; often a
Class can have one or more StateMachine
diagrams to fully describe its potential
states.

Visualize
Package

Package diagrams help you design the
architecture of the system; they are used
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Arrangement to organize diagrams and elements into
manageable groups, and to declare their
dependencies.

Follow the
Flow of Code

Activity diagrams help you develop a
better understanding of the flow of code.
Activity diagrams illustrate the dynamic
nature of the system; you can model the
flow of control between Activities and
represent the changes in state of the
system.

Simple Class Diagram
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Notes

You can use StateMachine, Package and Activity·

diagrams to better understand the interaction between
code elements and the arrangement of the code
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Project Managers

Enterprise Architect provides support for the management
of projects. Project Managers can use the system to assign
resources to elements, measure risk and effort, estimate
project sizes, and manage element status, change control and
maintenance.

Project Manager Tasks

Task Detail

Provide
Project
Estimates

In Enterprise Architect you have access
to a comprehensive project estimation
tool that calculates effort from Use Case
and Actor objects, coupled with project
configurations defining the technical and
environmental complexity of the work
environment.

Resource
Management

Managing the allocation of resources in
the design and development of system
components is an important and
sometimes difficult task; Enterprise
Architect provides you with an effective
tool for assigning resources directly to
model elements and tracking progress
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over time.

Risk
Management

You can use the Risks window to assign
risk to an element within a project; using
risk types you can name the risk, define
the type of risk and give it a weighting.

Maintenance Within Enterprise Architect you can
assign maintenance-related items to
elements and track them, providing rapid
capture and record keeping for items such
as issues, changes, defects, and tasks.
You can also create and maintain a
project glossary of processes, procedures,
terms and descriptions.
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Testers

Enterprise Architect provides a design testing facility for
Testers and Quality Assurance personnel to create a range of
test scripts against elements in the modeling environment.

Testing Tasks

Task Detail

Test Cases With Enterprise Architect, you can set up
a series of tests for each model element.
The test types include Unit, Acceptance,
System, Integration, Inspection and
Scenario tests.

Import
requirements,
constraints
and scenarios

To use testing to maintain the integrity of
the entire business process, you can
import requirements, constraints and
scenarios defined in earlier iterations of
the development life cycle.
Requirements indicate contractual
obligations that elements must perform
within the model.
Constraints are conditions that must be
met in order to pass the testing process;
constraints can be:
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Pre-conditions (statesthat must be true·

before an event is processed)
Post-conditions (events that must occur·

after the event is processed) or
Invariant constraints (which must·

remain true through the duration of the
event)

Scenarios are textual descriptions of an
object's action over time and can be used
to describe the way a test works.

Create
quality test
documentatio
n

Enterprise Architect provides the facility
to generate high quality test
documentation in .RTF, DOCX and PDF
file formats.

Element
defect
changes

In defect tracking you can allocate defect
reports to any element within the model,
so that all who are involved in the project
can quickly view the status of defects and
see which defects have to be addressed
and which have been dealt with.
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Implementation Managers

Enterprise Architect provides support for the management
of project implementation. You can track and assign
maintenance -related items to elements within Enterprise
Architect, and rapidly capture and update records of
maintenance tasks such as issues, changes, defects and
tasks. By providing a centralized facility for each element
involved in the deployment process Enterprise Architect
offers a powerful solution for tracing the maintenance of the
items and processes involved in system deployment.

Implementation Tasks and Tools

Task Detail

Develop
Deployment
Diagrams

Using Deployment diagrams, you can
model the roll out of a project, including
network deployment and workstation
deployment.
Users involved in project deployment can
add maintenance tasks to the diagram
elements.
Deployment diagrams provide a static
view of the run-time configuration of
nodes on the network or of workstations,
and the components that run on the nodes
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or are used in the workstations.
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Technology Developers

Technology Developers are Enterprise Architect users who
create customized additions to the functionality already
present within Enterprise Architect.

Additions include UML Profiles, Patterns, Code Templates,
Tagged Value Types, Scripts, Custom Queries,
Transformations, MDG Technologies and Enterprise
Architect Add-Ins. By creating these extensions the
Technology Developer can customize the Enterprise
Architect modeling process to specific tasks and speed up
development.

Developing Technologies

Extension Detail

UML
Profiles

By creating UML Profiles you can create
a customized extension for building UML
models that are specific to a particular
domain.
Profiles are stored as XML files and can
be imported into any model as required.

Patterns Patterns are sets of collaborating Objects
and Classes that provide a generic
template for repeatable solutions to
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modeling problems.
As Patterns are discovered in any new
project, you can publish the basic Pattern
template.
Patterns can be re-used with the
appropriate variable names modified for
any future project.

Code
Templates

Code templates are used to customize the
output of source code generated by
Enterprise Architect; in this way you can
generate code languages not specifically
supported by Enterprise Architect and
define how the system generates source
code to comply with your own company
style guidelines.

Tagged
Value Types

Tagged Values are used in Enterprise
Architect to extend the information
relating to an element in addition to the
information directly supported by the
UML language.
A Tagged Value, strictly, is the value of a
property of a modeling item, the property
being called a tag; for example: a Class
element called Person might have a tag
called 'Age' with the Tagged Value of
'42'.
More loosely, the combination of tag and
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value can be referred to as a Tagged
Value.
A Tagged Value Type is a group of
parameters that define and/or limit the
possible values of a tag and, in many
instances, how a specific value is
assigned to the tag; for example, the tag
'Age' might have a Tagged Value Type of
'Integer', so the user simply types in a
numeric value.
Alternatively, the type could be 'Spin',
with lower and upper limits of, say, 20
and 120, so the user sets a value by
clicking on arrows in the field to
increment or decrement the value within
the limits of 20 and 120.
Typically, Tagged Values are used during
the code generation process, or by other
tools to pass on information that is used
to operate on elements in particular ways.

MDG
Technologies

MDG Technologies can be used to create
a logical collection of resources that can
contain UML Profiles, Patterns, Code
Templates, Image files and Tagged Value
types that are accessed through a
technology file.

Enterprise Using Add-Ins you can build your own
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Architect
Add-Ins

functionality into Enterprise Architect,
creating your own mini programs that can
extend the capabilities of the system,
defining your own menus, and creating
your own Custom Views.
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Database Developers

Enterprise Architect supports a range of features for the
development of databases, including modeling database
structures, importing database structures from an existing
database and generating DDL for rapidly creating databases
from a model.

Database Development Tasks

Task Detail

Create
Logical Data
Models

With Enterprise Architect you can build
database diagrams using the built-in
UML Data Modeling Profile.
This supports the definition of Primary
and Foreign keys, cardinality, validation,
triggers, constraints and indexes.

Generate
Schema

By using Enterprise Architect's DDL
generation function you can create a DDL
script to create the database table
structure from the model.
Enterprise Architect currently supports:

DB2·

Firebird·
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MS Access·

MySQL·

MS SQL Server·

Oracle·

PostgreSQL·

Informix (#)·

Ingres (#)·

InterBase (#)·

Sybase Adaptive Server Anywhere (#)·

Sybase Adaptive Server Enterprise (#)·

(#) - no further development will be
undertaken on these DBMSs, due to a
general lack of interest for these products
from the Enterprise Architect user base.
This will allow Sparx Systems to
concentrate its efforts on the other areas
of Database modeling.

Reverse
Engineer
Database

Using an ODBC data connection you can
import a database structure from an
existing database to create a model of the
database.
By generating the model directly from the
database you can quickly document your
work and create a diagrammatic account
of a complex database through the
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graphical benefits of UML.

Example Data Model Diagram
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Formal Review Elements

A Review element is a simple yet powerful mechanism for
capturing, in real time, discussions concerned with a
particular event on one or more elements and/or diagrams.
Typically, a Project Manager or other coordinator will
create a Review element specifically to discuss one or more
objects for a project phase, project stage or other category of
review, over a defined period. A number of reviewers then
'join' the review and enter discussion points and responses in
the Collaborate window. Note that you can only be joined to
one Review element at a time.

The most direct and structured scenario would be for the
review coordinator to create the Review element through the
Reviews window. The Review element is a composite
element that generates a child diagram, and the review
coordinator would then add the elements and/or diagrams
(as Navigation Cells) to be reviewed to that child diagram.
A joined reviewer simply selects objects on the diagram and
adds topics or responses on each object to the 'Review' tab
of the Collaborate window.

The Review element also acts as a bridge to continue
focused discussions in subsequent work sessions.

The review comments pertinent to an element can be
displayed in that element on a diagram, in the Review
Compartment of the element.

This feature is available in releases of Enterprise Architect
from 14.0 onwards.
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If you want to simply comment on or discuss an element or
diagram without capturing your discussion in a formal
review, use the 'Discuss' tab of the Collaborate window. See
the Informal Discussions Help topic.

Using Review Elements

Review elements are used to plan and coordinate a formal
review of part of your model, defining:

When the review is to start and end·

What elements or diagrams are to be reviewed (and, as the·

review progresses, which objects have not yet been
reviewed)

The current status of the review·

Any specific instructions for performing the review·

Who is involved in the review·

Any resources to use during the review·

The priority of the review·

The start and end date information is defined in two special
EAReview Tagged Values (on the Review element
'Properties' dialog, see the 'General' page and 'EAReview'
tab):

EndDate - the date on which the Review will be complete·

with no further discussions expected

StartDate - the date from which users can join the review,·

and add discussions and responses

Other information can be provided through the Review
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element's normal element properties including Linked
Documents, Notes and associated Note elements, Tagged
Values and attributes. Review elements and their contents
can be the subject of searches and document generation, all
of which add to the information-gathering and grouping
purposes of the element. The element also has a child
diagram that aids planning, management and coordination of
the review, and that provides a quick overview of and access
to the elements under review.

Review elements can be used in a number of contexts,
including model development, testing, delivery,
maintenance and management. They can be added to
specific Review diagrams - which have their own 'Review'
Toolbox page - or to more general diagrams, using 'Review'
icons from the 'Review', 'Artifact', 'Maintenance' or
'Management' toolbox pages.

Review elements are generally set up and managed within
Enterprise Architect, but users both of Enterprise Architect
and of the WebEA facility can use Review elements to
direct their input to discussions on project and model
reviews.

Creating a Review element

Typically, to create a Review element:

Open the Reviews View ('Start > Collaborate > Reviews1.
> All Reviews').
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Right-click on the View background and select the 'New2.
Review' option; the 'Create Review' dialog displays, with
the 'Name' field defaulting to the name of the
currently-selected Package.

If necessary, overtype the name with a different Review3.
element name.

In the 'Status' field click on the drop-down arrow and4.
select the appropriate status.

In the 'Start' field, click on the drop-down arrow and5.
select the date on which the review starts.

In the 'End' field, click on the drop-down arrow and select6.
the date on which the review should complete. Click on
the OK button.

In response to the prompt for the owner Package, either7.
accept the current Package or browse for a different
Package. Click on the OK button.

You are automatically joined to the review, in the8.
Collaborate window, and can create some initial
discussion points. A Review diagram is automatically
created and displayed, containing the Review element.

Alternatively, you could start by creating a Review diagram
(a Custom diagram in the 'Extended' category) or a diagram
of any other type, and drag onto it the 'Review' icon from
the Diagram Toolbox (as indicated in the Using Review
Elements section); the icon and element have these
appearances:
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The element defaults to the Infoview display format, which
you can edit or disable. You would then display the element
'Properties' dialog and provide the start and end dates on the
'General' page 'EAReview' tab.

Locating Review elements

In order to join a review, you have to locate the available
Review elements and select the appropriate one.

Select the 'Start > Collaborate > Reviews > All Reviews'
ribbon option. The Reviews window displays, showing the
Review elements that exist in the model, grouped according
to the 'Status' value.

Having listed the available reviews, you can join one by
right-clicking on it and selecting the 'Join Review' option.
This makes the review your Active Review, and the entry
displays in bold. (Right-click on the View background and
select the 'Refresh' option.)

Further information on the Reviews window is provided in
the Manage Reviews section later in this topic.

There are a number of alternative options for locating
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Review elements. In the header of the 'Review' tab in the
Collaborate window, click on the  icon and select one of
these options:

'All Reviews' to open the Reviews window, as just·

described, to list all Review elements

'Review Details' to display the discussion history of your·

current review, and to show the details of the elements
reviewed

'Find Current Review' to locate your active Review·

element in the Project Browser

You can also select four reports from the 'Find in Project'
window, Discussions group (select the 'Start > Explore >
Search > Model' ribbon option and the 'Discussions' option
in the drop-down list in the first field):

Review - Lists the Review elements that exist in the·

model

Recently Modified Reviews - Generates a list of Review·

elements that have been recently created or modified

Recently Discussed Reviews - Generates a list of Review·

elements in which discussions have taken place

Open Reviews - Generates a list of Review elements with·

the status 'Open', which can be joined for discussion

Performing Reviews

To join a review, select the 'Start > Collaborate > Reviews >
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All Reviews' option, right-click on the required review from
the Reviews window and select the 'Join Review' context
menu option.

Alternatively, to join a review you could:

Right-click on the appropriate Review element in a·

diagram, the Project Browser or the results of a model
search, and select the 'Join Review' context menu option

If a review is shown in the 'Review' tab of the Collaborate·

window, right-click on it and select the 'Join Review'
option; the name of the review element then becomes the
button name at the top of the screen, and the review topics
for the currently selected model element display in the
body of the window

When a user has joined a review, that is their Active review
until they leave the review again. The Review element links
to the review topics and posts of each joined user until they
either log out of the model or select the 'Leave Review'
context menu option.

When you log back into the model, and/or want to continue
adding to the review, you can join it again using the 'Join
Review' menu option.

Contributing to a Review

After you have joined a review, select the 'Start >
Collaborate > Reviews > Review' ribbon option. The
Collaborate window displays at the 'Review' tab.
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Click on the element or the Navigation Cell for the diagram
that you want to comment on, in the Review diagram or the
'Details' tab of the Reviews window, to make that object the
focus of the Collaborate 'Review' tab.

Alternatively, click on the object to review in the Project
Browser or a non-Review diagram and:

Right-click on the object > Collaborate > Review·

To create a topic for review or make a response to a topic,
use the guidelines provided in this table.

Operation Action

Create a
review topic

At the end of any existing review
conversation, the message Create Review
Topic displays. Double-click on the
message and type your topic as
continuous text (no carriage returns). The
text automatically wraps at the border of
the Collaborate window.
If you do need to break your text into
paragraphs, press Ctrl+Enter at the break
point.
When you have finished typing, click off
the text or press the Enter key.

An open expansion arrow and a  icon·

display at the start of your text, and
your user name, the time or date of
posting and the number of responses
(initially zero) display beneath your
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text
The messages Post Reply and Create·

Review Topic display below the topic
If user security is enabled and you have
selected to show avatars, the review icon
is replaced by an image representing the
user who contributed that item. If the user
does not have a personal avatar image, a
default 'head and shoulders' silhouette
displays as the avatar.

Add a
response

Double-click on the 'Post Reply' message
and type your response as continuous
text.
When you have finished typing, click off
the text or press the Enter key.

A  icon, your user ID and the time of·

posting display above your text
The message Post Reply displays·

beneath your text
You can also right-click on a post and
select the 'Post Reply' menu option. All
new replies are added underneath the
review thread they are in response to.

Edit postings Whilst you are typing a message, the
editor automatically checks the spelling
and underlines possible spelling errors in
red. You can backspace or move the

(c) Sparx Systems 2018 Page  51 of 260



User Guide - Team Support 21 December, 2018

cursor to the errors to correct them. You
can also move the cursor anywhere in the
message body and add or delete text
(press the Delete key).
Once you have posted a message, you can
delete the whole message but you cannot
edit it.

Copy review
topic text

If you want to re-use some or all of the
text of a review item, select the text
before you save it and press Ctrl+C to
copy it to the clipboard. You can then
paste the text into a new review item or
into another document in Enterprise
Architect. You can also paste copied text
from the clipboard into the review item,
by pressing Ctrl+V.

Set review
topic status

A new review topic has the status of
'Open', with no indicator. To change the
status, right-click on the item and select
either:

'Status | Awaiting Review' to indicate·

that some form of confirmation or
approval is required for the point raised
in the review topic (the indicator 
then displays to the right of the topic)
or
'Status | Closed' to indicate that users·
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should not add any further comments to
the thread (the indicator  then
displays to the right of the topic)

If the review topic already has one of
these statuses, you can also select the
'Status | Open' option to return the topic
to 'Open' status, indicated by the  icon.

Set review
topic priority

As part of the review, you might want to
identify the priority of a point being
raised. It might be very important to act
on the point, or it might be agreed that the
point discusses a 'nice to have' feature
that could be addressed at a later date. To
set the priority, right-click on the review
topic and select one of the options:

'Priority | High' ( )·

'Priority | Medium' ( ), or·

'Priority | Low' ( )·

Alternatively, if you decide that an item
does not need to be prioritized, select the
'Priority | <none>' option. This leaves the
item icon as .

Delete a
review topic
or reply

Right-click on the review topic or a reply,
and select the 'Delete Selected' menu
option. A prompt displays to confirm the
deletion. Click on the Yes button.
If you delete a review topic, all replies

(c) Sparx Systems 2018 Page  53 of 260



User Guide - Team Support 21 December, 2018

associated with that topic will be deleted
as well.

Manage Reviews

Select the 'Start > Collaborate > Reviews > All Reviews'
ribbon option.

(Alternatively, click on the 'In Review' button across the top
of the 'Review' panel in the Collaborate window and select
the 'All Reviews' option.)

This displays an overview of all Review elements in your
model, enabling you to quickly see what reviews are taking
place and what is happening within any review you want to
explore.

If you are already joined to a review, your active Review
element is displayed in the list in bold. Otherwise, you can
join a review by right-clicking on the Review element name
and selecting the 'Join Review' option. Equally, you can
leave your active review by right-clicking on it and selecting
the 'Leave Review' option.

Right-click on the Review item you have joined, and select
the 'Review Details' option to display the Reviews window
at the 'Details' tab.

For each Review element there is a 'Set' segment that
identifies the elements to be reviewed as added to the
Review diagram. Additionally, there is an 'Other' segment
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that identifies any review activity on the Review element
itself, or on any other elements in the model that are added
to the review but not included on the diagram.

The columns of the display show a number of properties of
each element in the review.

These properties include the start and end dates of the
review period, the number of topics posted for the element,
the number of those topics open or awaiting review and the
number closed, the number of topics and replies posted in
the last three days, between three and fifteen days ago, and
more than fifteen days ago. You can change the sequence of
these columns if you prefer, by dragging the column
headings across the heading band.

You can right-click on:

The column headers to add or remove columns using the·

'Field Chooser', and to display the Filter bar to filter the
list for review topics having a specific property

An element name to display the element Review topics·

and comments on the 'Review' tab of the Collaborate
window

An element name to find the element in the Project·

Browser (or double-click on the item); this also opens the
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Collaborate window for the element

An element name to locate any diagrams that contain the·

element

The window and select the 'Refresh' option to refresh the·

list, to include any review topics that have been posted
since you opened the review

The 'Field Chooser' dialog offers additional columns to add
to the Review listing.

If you are not joined to a review, you can also create a new
Review element by clicking on the 'New Review' option, as
explained at the top of this topic.
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Informal Discussions

Using the 'Discuss' tab of the dockable Collaborate window,
you can select an individual element or diagram and develop
an informal discussion that is directly associated with that
object. This makes it easy to locate, view and contribute to a
discussion, or more than one discussion, on the selected
object.

You can participate in discussions on different elements and
diagrams simply by clicking on each object in turn; the
Collaborate window immediately switches to the discussion
of the new selected object, identified by name underneath
the window option bar.

As a discussion develops, the number of responses is shown
below the original post; therefore you can see when a
discussion has a new reply without having to expand and
work through the thread. You can apply a priority and status
to a discussion, which helps you to indicate the importance
of the discussion and to resolve and close off the points
raised in the discussion so that they do not continue
indefinitely. You can also delete the whole posting or
specific replies, to balance retaining discussion history with
removing irrelevant information.

Three further facilities of the Collaborate window are the:

'Review' tab, which you use to attach formal discussions·

on one or more elements and/or diagrams to a review
session, encapsulated in a Review element; see the
Formal Review Elements Help topic
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'Chat' tab and text box, which you can use to follow and·

participate in quick conversations on a point of interest,
not necessarily connected with the selected element; see
the Model Chat Help topic

'Journal' tab, on which you jot down any notes, comments,·

reminders or references that you want to write down
during the day; see the Keeping Journal Entries Help
topic

The discussion comments pertinent to an element can be
displayed in that element on a diagram, in the Discussion
Compartment of the element.

Access

Select an element or diagram, then open the Collaborate
window using one of these methods:

Ribbon Start > Collaborate > Discussions >
Discuss

Context
Menu

Project Browser > Right-click on object >
Collaborate > Discuss
On diagram > Right-click on element >
Collaborate > Discuss
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Operations in Discussions

Operation Action

Create a
discussion

The window displays the message Create
new Discussion. Double-click on this
message and type your posting as
continuous text (no carriage returns). The
text automatically wraps at the border of
the Collaborate window. You can also
paste copied text from the clipboard into
the discussion item, by pressing Ctrl+V.
If you do need to break your text into
paragraphs, press Ctrl+Enter at the point
at which to break the text.
When you have finished typing, click off
the text or press the Enter key.

An open expansion arrow and a  icon·

display to the left of your text
Your user ID and the time of posting·

display just underneath your text,
followed by the text 0 Replies
The messages Post Reply and Create·

new Discussion display beneath your
text

You can also right-click on the window
and select the 'Create new Discussion'
menu option. All new discussions are

(c) Sparx Systems 2018 Page  59 of 260



User Guide - Team Support 21 December, 2018

added below existing discussion threads.
If user security is enabled and you have
selected to show avatars, the discussion
icon is replaced by an image representing
the user who contributed that item. If a
user does not have an avatar image, a
default 'head and shoulders' silhouette
displays as the avatar.

Add a
response

Double-click on the 'Post Reply' message
and type your response as continuous
text.
When you have finished typing, click off
the text or press the Enter key.

A  icon, your user ID and the date·

and time of posting display above your
text
The message Post Reply displays·

beneath your text
The Replies count is incremented·

underneath the original posting
You can also right-click on a post and
select the 'Post Reply' menu option. All
new replies are added underneath the
discussion thread they are in response to.

Edit postings Whilst you are typing a message, the
editor automatically checks the spelling
and underlines possible spelling errors in
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red. You can backspace or move the
cursor to the errors to correct them. You
can also move the cursor anywhere in the
message body and add or delete text
(press the Delete key).
Once you have posted a message, you can
delete the whole message but you cannot
edit it.

Copy
discussion
text

If you want to re-use some or all of the
text of a discussion item, you can copy it
to the clipboard by selecting the text and
pressing Ctrl+C before you save it. You
can then paste the text into a new
discussion item or into another document
in Enterprise Architect.

Set
discussion
status

The  icon against a new discussion
indicates that the discussion has the status
of 'Open'. To change the status,
right-click on the discussion item and
select either:

'Status | Awaiting Review' ( ) or·

'Status | Closed' ( )·

If the discussion already has one of these
statuses, you can also select the 'Open'
option to return the discussion to 'Open'
status.
When you review the discussions in the
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Collaborate window, you might want to
include discussions that have the status of
'Closed', or you might prefer to hide
them. To toggle the inclusion of closed
discussions, right-click on the body of the
window and click on the 'Show Closed
Topics' option.

Set
discussion
priority

As part of the discussion, you might want
to identify the priority of a point being
raised. It might be very important to act
on the point, or it might be agreed that the
point discusses a 'nice to have' feature
that could be addressed at a later date. To
set the priority, right-click on the
discussion topic and select one of the
options:

'Priority | High' ( )·

'Priority | Medium' ( ), or·

'Priority | Low' ( )·

Alternatively, if you decide that an item
does not need to be prioritized, select the
'Priority | <none>' option. This leaves the
item icon as .

Delete a
discussion or
reply

Right-click on the discussion or a reply,
and select the 'Delete Selected' menu
option. A prompt displays to confirm the
deletion. Click on the Yes button.
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If you delete a discussion, all replies
associated with that discussion will be
deleted as well.

Review
Discussion
History

Either:
Click on the object name bar at the top·

of the window, or
Right-click within the body of the·

window, or
Select the 'Start > Collaborate >·

Discussions' ribbon option
In each case, select the 'Discussion
History' option.
The Discussions window displays, listing
all existing discussion items on elements.
You can right-click on the:

Column header band and select options·

to display the 'Field Chooser' and add
to or reduce the number of columns, or
to display the Filter bar to filter the list
for discussions having a specific
property such as the user who posted
the discussion items, or the person who
created the elements (element Author)
Body of the window and select to open·

a preview pane on the right or at the
bottom of the window, to instantly see
each discussion thread as you click on
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it in the list; you can also hide the
preview pane if you do not need it
Body of the window and on the 'Visible·

Timeframe' option, selecting to show
discussions posted today, or during the
7, 30 or 90 days prior to today
Body of the window and select to·

refresh the list to include any
discussions that have been posted since
you opened the discussion history
Selected element and select to:·

    - Find the discussed element in the
Project Browser or diagrams
    - Display the 'Properties' dialog for
the discussed element
    - Review and edit the discussion in
the Collaborate window, opening the
window if it is
       not currently available

Notes

The Discussions facility is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

If the editor does not highlight spelling errors, select the·

'Start > View > Preferences > Objects' ribbon option and
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deselect the 'Disable Spelling' checkbox

A standard report is available for locating elements that·

have recently been the subject of discussions; select the
'Start > Collaborate > Discussions > Find Recently
Discussed Elements' ribbon option

(c) Sparx Systems 2018 Page  65 of 260



User Guide - Team Support 21 December, 2018

Model Chat

The Collaborate window has a 'Chat' tab that provides the
facility of following and participating in quick conversations
on a point of interest, with members of a selected user
group.

The user groups are those defined in User Security, which
must be enabled in order for the Chat facility to be available.

Each initial comment or response is a separate message,
listed in date/time order, with the most recent message at the
top of the list. The messages are independent of the
currently selected model object and the full list displays
whenever the user group is selected in the 'Chat' tab. As the
messages are independent of any model object, they do not
appear in the 'Discussions' tab (All Discussions) or 'Recently
Discussed Elements' report (which are element-based).

If you simply want to make notes for yourself, you can use
the 'Journal' tab on which you jot down any notes,
comments, reminders or references that you want to record
during the day.

You can filter the messages by the time interval prior to
today, and you can set up a check to notify you when new
messages are posted by members of one or more user
groups.

This is an example of a Chat session:
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Access

Ribbon Start > Collaborate > Discussions > Chat

Context
Menu

Project Browser > Right-click on element
> Collaborate > Chat
On diagram > Right-click on element >
Collaborate > Chat

Select a User Group
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Initially, the button at the top of the 'Chat' tab displays the
name 'Select a Discusion Group'. Click on the button and on
the name of the user group to send messages to. The name
of the currently-selected user group then becomes the name
of the button.

If you want to communicate with a different group, click on
the button again and select the name of that group.

If you do not want to continue chatting, you can select
'Disconnect from current Discussion'.

Create a message

Step Description

1 At the top of the 'Chat' tab, in the text
field, type your message. You can
right-click on the text and select from a
number of editing context menu options,
and you can create glossary terms and
new elements from highlighted text, or
links to existing elements. You can also
paste in copied text from the clipboard,
by pressing Ctrl+V.
If you want to create a paragraph break,
press Ctrl+Enter (the Enter key alone will
submit the message).
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2 When you have completed your message,
click on the Send button or press the
Enter key. The message displays in the
list underneath the text field.
If you have selected to show avatars (the
'Configure > Security > Administer >
User Settings > Show user avatars' ribbon
option), all messages show an image
representing the user who contributed
that message. If a user does not have an
avatar image, a default 'head and
shoulders' silhouette displays as the
avatar.

Review Messages

Once a message has been sent, it cannot be edited. If you
want to re-use the text of a message item, you can copy
some or all of the message to the clipboard by pressing
Ctrl+C before you send it. You can then paste the text into a
new chat item or into another document in Enterprise
Architect.

You can also delete a message by right-clicking on it and
selecting the 'Delete Message' option.

Messages sent by other people to the currently-selected User
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Group display in your screen immediately. Messages
deleted by other users do not disappear immediately. To
update your list, right-click on it and select the 'Reload
Messages' option.

Monitor User Groups for Messages

You can set the system to monitor selected user groups, to
notify you when a member of one of those user groups posts
a message whilst the 'Chat' tab is either set to a different
user group or not visible.

The notification is a New Model Discussion button that
displays in the bottom right of the Status Bar when a
message is posted from a selected user group. The button
also displays if a message is posted in the thread you have
been reading, and the 'Chat' tab is not visible. Click on the
button to redisplay the 'Chat' tab with the message thread.

If you are monitoring more than one user group, the New
Model Discussion button provides a menu to indicate which
of the selected groups has posted a new and unread
message. When you click on a group, the 'Chat' tab displays
with the appropriate thread of messages.

To set up a check for messages from a user group:

Click on the 'Options' icon on the right of the 'Chat' tab,1.
and select the 'Monitor Groups for new Messages' option.

Select a user group to monitor. If you want to monitor2.

(c) Sparx Systems 2018 Page  70 of 260



User Guide - Team Support 21 December, 2018

more than one group, either:
    - Do steps 1 and 2 again for each individual group to
monitor, or
    - Select the 'All' group to check for messages from any
of the user groups

Select the 'Monitor Groups for new Messages' option3.
again, and click on the 'Check for new Messages Every'
option. Click on the interval of time at which the system
will check for new messages - every minute, or up to
every ten minutes.

If you want to cancel monitoring a specific group, repeat4.
steps 1 and 2. Clicking on a selected group will deselect
it.

If you want to cancel monitoring all of the selected5.
groups, perform step 1 and then click on the 'None'
option.

Filter messages by age

The 'Options' icon provides the 'Message Visibility' option,
to limit the display of messages to those posted within a
certain number of days prior to today's date.

When you select this option, a menu displays from which
you select to display only messages posted today (the
default), or within the last 7, 30 or 90 days.

If you do not want to limit the display of messages to an
interval you have set, you can cancel it by selecting the 'All'
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option.
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Introducing the Journal

Enterprise Architect provides a great facility for maintaining
a daily journal, in which you can type all kinds of ideas,
comments, notes, suggestions, events, to-do lists and other
reminders of what you have done or intend to do within the
model. This is a great way to keep the momentum flowing
day to day. The facility is simple to use, allowing you to
quickly jot down your thoughts as they occur to you.

The 'Journal' page is part of the Collaborate window, which
allows you to take notes as you engage in formal or informal
discussions and chats with other team members, as well as
during your work on other screens and dialogs.

Because the Journal entries are specific to your login, this
facility is only available within a model for which User
Security has been enabled.

Access
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Ribbon Start > Collaborate > My Journal

Creating the first Journal Entry

When you first access the Journal page, it has the single
entry 'Today' in the 'Date' column. You can type freely in
the 'Journal Entry' column against 'Today', including
carriage returns and text formatting. Right-click on selected
text to access the editing options, which include:

Creating a Glossary definition from the text, and inserting·

existing definitions in the text

Generating a new element in the same Package, with the·

selected text as the name and linked to the text

Creating a link from the selected text to an existing·

element in the model (in the Notes window only)

Creating a hyperlink to a wide range of target objects,·

including image files, diagram images, web pages, text
files, Help topics and Enterprise Architect commands

Searching for instances of the selected text in a range of·

sources (options derived from the 'Code Editor' context
menu)

Editing the text, with cut, copy, paste and delete, setting·

fonts, and setting paragraph format
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When you have finished typing your note, click off the
Collaborate window.

You can return to the Journal Entry at any time and:

Add further notes; you use the same Journal Entry to·

record all your notes and comments throughout the day

Edit the existing text, including reformatting·

Delete text or complete notes; select the text and click on·

the Delete key or use the 'Delete' context menu option

Journal Entries Each Day

Every day, when you open Enterprise Architect and the
'Journal' page, it has a 'Today' item at the top, against which
you record the day's Journal entries. Beneath the 'Today'
item are the entries for previous days, identified by the date
on which you made them. This only list dates on which you
have made an entry; there are no blank lines for days on
which you did not make an entry.
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As well as formatting and editing today's entry, you can edit
the entries for previous days. This means you can remove
information that is no longer relevant (such as old
reminders) or things you listed to be achieved that you have
now completed. On the other hand, you can also highlight
entries that are still significant, and refer back to them from
the 'Today' entry.

Whilst the Today entry is always at the top of the page, you
can change the order of display of earlier entries to show the
oldest first, or the most recent. Simply click on the column
heading to change the sort order.
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User Security

User Security in Enterprise Architect is a means of blocking
the use of model update functions across the model by
means of access permissions for each function, and
protecting specific elements and diagrams from change by
means of user locks. The intent is not to prevent access to
information, but to prevent inadvertent changes to data.

Security is an optional facility in the system. If required it is
enabled by the Security Administrator, who at the same time
sets the security policy to either:

Require User Lock to Edit - the whole project is blocked·

against editing and the user locks an object to open it and
edit it, or

User/group locking - the whole project is open for editing·

and the user locks an object to protect it from being edited

The Security Administrator also sets up the user and group
IDs and passwords, which every user requires to log in to
the model when security is enabled. Access permissions are
assigned to the user IDs to determine which update
functions the user can apply. The users can still view any
information in the project. If security is not enabled in the
project, no login is required and users do not have to have
access permissions to perform update functions.

Access
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Ribbon Configure > Security

Security Operations

Operations
For

Detail

Administrato
rs

A number of security tasks can be
performed only by users with
Administrative permissions to the
security operations. The person who
enables security receives online
instructions to login as Admin. This login
ID automatically:

Has access permissions to perform all·

security operations
Is a member of an Administrators user·

group, which also has access
permissions to perform all security
operations

Users Other security tasks can be performed by
users who do not have Administrative
rights, on work performed under their
own user ID. These users must still have
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the appropriate access permissions to
perform many of these 'user' tasks.

Notes

User Security can be enabled in the Corporate, Unified·

and Ultimate editions of Enterprise Architect

(c) Sparx Systems 2018 Page  79 of 260



User Guide - Team Support 21 December, 2018

Enable/Disable Security

User security is not automatically enabled on the system. If
your organization requires the security facilities, the
Security Administrator enables them using an authorization
key obtained from the Sparx Systems website. Similarly, if
security facilities are no longer required, the Security
Administrator explicitly disables security, again using the
authorization key.

Access

Ribbon Configure > Security > Administer >
Enable Security

Enable and Disable User Security

Ste
p

Action

1 Obtain the authorization key from the Sparx Systems
website on:

the 'Team Modeling Resources' section (Trial·
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User) or
the 'Registered Users' section (Registered User;·

you must also have your Registered Users login
and password)

The two authorization keys are not interchangeable -
the Trial User key does not work on a registered user
installation.

2 In Enterprise Architect, select the 'Enable Security'
menu option.
The 'Enter authorization' dialog displays.

3 In the 'Enter authorization key' field, type the
authorization key from the Sparx Systems website.

4 If required, select the 'Automatically apply Exclusive
Edit Locks to diagrams' checkbox.
In standard (User/Group Locking) mode, this option
blocks multiple users from simultaneously
attempting to modify the same diagram (see Notes).
This option is ignored in 'Require User Lock to Edit'
security mode.

5 Click on the OK button.
Security is enabled, and an Admin user and
Administrators user group are created, both with all
access permissions; the Admin user has the
password of 'password'.
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6 Select the 'Configure > Security > Administer >
Login as Another User' ribbon option, and log in as
'admin' with the initial password of 'password'.
It is recommended that you change the Admin
password immediately.

7 Set up users and permissions as required.

Notes

Once security has been enabled, you must have·

'Security-Enable/Disable' permission to turn it off - the
initial Admin administrator and Administrators group
automatically have this permission; the system prompts
you to log off the project and log on again, but this is not
strictly necessary

If you re-enable security, be aware that any changes you·

have made to the Admin user (password and reduced
access permissions) are reset to 'password' and full access;
similarly, the Administrators user group is reinstated with
full access permissions

The 'Automatically apply Exclusive Edit Locks to·

diagrams' option is not displayed when disabling security,
therefore to toggle the setting whilst security is enabled
you must disable security and re-enable it; security
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settings (users, groups and permissions) and locks on
elements are not affected by this action

If the 'Automatically apply Exclusive Edit Locks to·

diagrams' option is selected, as a user modifies a diagram
the system automatically applies a User Lock to the
diagram, preventing any other user from modifying it
It is creating a difference between the database and buffer
versions of the diagram that triggers the temporary lock,
and elimination of difference that releases the lock;
therefore, the system releases the lock when:
-  The user saves the changes to the diagram, with the
Save icon or keyboard keys
-  The user undoes the last remaining action in the 'Undo'
list
-  The user saves or discards changes via the system
prompt when they close the diagram

If the diagram already has a User Lock or Group Lock
that does not exclude the current user, this lock is set aside
and saved when the temporary User Lock is applied;
when the temporary User Lock is released, the
pre-existing lock is restored

(c) Sparx Systems 2018 Page  83 of 260



User Guide - Team Support 21 December, 2018

Set Security Policy

The security policy determines how security mechanisms
are applied and interpreted on the system. There are two
possible security policies in Enterprise Architect:

User/Group Locking mode - All elements and diagrams·

are considered unlocked and anyone can edit any part of
the model; however, when you edit a diagram, Package or
element, you lock the element or set of elements at either
the user level or group level and no other user can edit the
object
This mode is good for cooperative work groups where
there is a solid understanding of who is working on which
part of the model, and locking is used mainly to prevent
further changes or to limit who has write access to a part
of the model

Require User Lock to Edit mode - More rigorous: the·

model is read-only, and everything is locked so that
nobody can edit anything unless they explicitly check out
the object with a user lock; a single 'check out' function
operates on a diagram to check out the diagram and all
contained elements in one go.
There are also functions on the context (right-click)
menus of Packages, diagrams and elements in the Project
Browser to apply a user lock when this mode is in use
You would use this mode when there is a strict
requirement to ensure only one person can edit a resource
at one time; this is suitable for much larger projects where
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there might be less communication between users

For element locking, the two policies are modified by the
'Apply Locks to Connectors' menu option. If this option is:

Selected, security locks on elements are applied to all·

connectors owned by the locked elements (users other
than the locking user cannot edit the connectors)

Unselected, security locks on elements do not apply to the·

owned connectors

Access

Ribbon Configure > Security > Administer >
Require User Lock to Edit (select for
'Require User Lock to Edit' mode,
deselect for 'User/Group Locking' mode)

Notes

Only the Admin Security Administrator, with Admin·

permissions, is able to set the security policy applied

When you add new elements in 'User/Group Locking'·

mode (elements editable by default), no user lock is
created automatically for the newly created element

When you add new elements in 'Require User Lock to·
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Edit' mode (elements locked by default), a user lock is
created on the new element to enable instant editing

For all connectors other than Aggregations, the connector·

is owned by the source element in the relationship (as
currently applied in Version Control)
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Maintain Groups

Whilst you can apply access permissions to each user
individually, it is easier and more convenient to assign all
users with the same access permission(s) to a security group,
and assign the permissions to all the members of that group
in a single action.

The security group also acts as a mailbox for Model Mail,
where the group name can be selected as the addressee;
when an internal mail is sent to the group, all members of
the group receive that email in their Model Mail view. The
group name can act as either:

A mail list, in which case each group member receives·

their own copy of the message, or

A mail box, in which case the email is a single entity and·

the group members do not receive separate instances of it;
if one group member responds to or deletes the email, the
other group members see that action as if they had
performed it themselves

Access

Ribbon Configure > Security > Groups
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Set up a security group

Field/Button Action

New Click on this button to clear the fields
ready to define a new group.

Group Name Type the security group name.

Description Type a description of the group.

Save Click on this button to save the group
definition and add it to the Groups list.

Link to
Active
Directory

Select this checkbox to enable linking to
a Windows Active Directory Group from
which to import users. The 'Select Group'
dialog displays on which you specify the
Windows Active Directory Group to
attach to. You then start importing the
users when you click on the Sync button.
You must have 'Accept Active Directory
Authentication' permission in Windows
to link to the Active Directory; an error
message displays if you do not have this.

OpenID
Group

This feature is available from Enterprise
Architect Release 14.1.
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OpenID groups can be linked to local
model groups - this is used if the option
to automatically create or modify OpenID
users is set. When a new user logs in they
will be assigned to the local groups that
correspond with the OpenID groups they
belong to. When an existing user logs in
they will be assigned to the linked
OpenID groups they belong to and
removed from any they don't belong to.
If OpenID login has been enabled for the
model, then local groups can be linked to
OpenID groups.
Type the name of the OpenID group to be
linked to the local model group, note that
the group name is case sensitive.
Note: OpenID login must be enabled in
the 'Security Users' dialog; see the
Maintain Users Help topic.

Shared Mail To make the group name act as a mail
box, select this checkbox against the
name in the list.
To use the group name as a mail list,
leave the checkbox unselected.

Active
Directory
Link

Displays the address of the Active
Directory Group that this user group is
linked to, if any.
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Sync Enabled if the group is linked to a
Windows Active Directory. Click on this
button to synchronize the group with the
Active Directory (that is, import specific
users into the model from the Active
Directory). You use this option when you
initially set up the User Group;
subsequent user IDs must be added to the
user group manually.

Permissions Lists the permissions that can be assigned
to the user group. Select the checkbox
against each permission the members of
the group are to have.

Users After you add users to the user group,
they are listed in this panel.

Close Click on this button to close the dialog.

Notes

You must have 'Security - Manage Users' permission to·

manage user groups; the initial Admin administrator and
Administrators group automatically have this permission
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You do not define groups as group logins with passwords;·

if you intend to use a group login, you can define a
single-user login and password that all group members
use (that is, Enterprise Architect allows multiple logins
under one user ID)

Users that have been imported from an Active Directory·

are listed in the 'Manage Users' dialog'; if the 'Accept
Windows Authentication' option is enabled on that dialog,
when a user opens the model the system checks the
database for their Windows ID and, if it matches,
automatically logs the user in without prompting for a
password

Emails already sent to a group as a mail list and those sent·

to a group as a mailbox cannot be interchanged; if you
change the status of the 'Shared Mail' checkbox, the only
way to change the distribution of past emails is to forward
them to the group name again

You can subsequently edit the group name; changes are·

automatically reflected in the internal Model Mail mail
list or mail box
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Maintain Users

When you have enabled security, you create the user
definition for each user that has access to the model. The
user definition consists of the user ID and password, the
permissions the user has, the user groups the user is a
member of, and whether the user ID is provided and
validated by external user authentication mechanisms.

Access

Ribbon Configure > Security > Users: New
The 'Security Users' dialog displays.

Set up a user for your model
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Ste
p

Action

1 You can manage users in multiple ways:
Set up the user manually, as described here·

Import the user IDs from a Windows Active·

Directory
Trust the user information from a third-party·

Single Sign-On system and allow it to manage
users

If you are importing the user IDs from a Windows
Active Directory, do not complete any user detail
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fields on this dialog, but select the 'Accept Windows
Authentication' checkbox and go to the Import User
IDs from Active Directory Help topic.
To allow automatic management of users by a single
Sign-On (SSO) system, tick the SSO mechanism to
use (either Windows or OpenID) and tick
'Automatically create or modify Windows or
OpenID users'. See Single Sign-On (SSO) Options
for more details.

2 In the:
'Login' field, type the user ID·

'Firstname' field, type the user's first name·

'Surname' field, type the user's last name·

Optionally, in the 'Department' field, type the name
of the user's department.
The 'Add User to Authors' checkbox defaults to
selected, to add the new user to the list of authors of
model elements. If the user is not to be added to the
list of authors, deselect the checkbox.

3 Click on the Save button, and then click on the
Change Password button.
The 'Change Password' dialog displays.

4 In the 'New password' field, type the user's
password.
This can be any number of characters in length.
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(As this is a new user, the 'Enter old password' field
is disabled.)

5 In the 'Retype new' field, type the user's password
again, for confirmation.

6 Click on the OK button.
A Password Changed message displays.
Click on the OK button to return to the 'Security
Users' dialog.

7 In the 'User Groups' panel, select the checkbox
against each user group that the user is to be a
member of. This assigns to the user all permissions
that the selected groups have.

8 In the 'User Permissions' panel, select the checkbox
against each permission that you want to assign to
the user as an individual. If a permission is grayed
out and already ticked, the user already has that
permission as a member of a User Group.

9 The top right corner of the Enterprise Architect
display shows your user ID, with a short drop-down
menu providing personal access options including
whether your login credentials are stored and
automatically applied when you open the model
('Remember Me'). If you want to use this option, you
must select the 'Allow 'Remember Me'' checkbox on
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this 'Security Users' dialog.

10 The user definition is complete. You can now either:
Click on the New button to add another user, or·

Click on the Close button to exit the 'Security·

Users' dialog

Notes

You must have 'Security - Manage Users' permission to·

maintain users; the initial Admin administrator and
Administrators group automatically have this permission

You can transport the user definitions between models as·

Reference Data, using the 'Configure > Model > Transfer
> Export Reference Data' and 'Import Reference Data'
options
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Single Sign-On (SSO)

Single Sign-On (SSO) enables a model to trust a third-party
authentication system to log in to a model. Instead of
logging in to Enterprise Architect, the user logs into a
third-party system that authenticates the user as valid and
allows them access to Enterprise Architect. Enterprise
Architect trusts the authentication returned from the SSO
system and logs the user in to the model.

Enterprise Architect supports two SSO systems:

Windows authentication with Active Directory·

OpenID - This feature is available from Enterprise·

Architect Release 14.1

SSO systems

Windows
Authenticatio
n

Windows Authentication allows a model
to trust the currently logged in Windows
user. If the username returned from the
Windows system matches a model user,
then the model is logged in as that user.
Windows Authentication works best
when run with an Active Directory
Domain.
You can enable Windows Authentication
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by selecting the 'Accept Windows
Authentication' checkbox on the 'Security
Users' dialog

OpenID OpenID is the current preferred standard
for SSO authentication for web sites. It
also works well for applications such as
Enterprise Architect. To use OpenID, an
OpenID server must be configured and
accessible by Enterprise Architect.
There are many options for OpenID
servers, including self-hosted servers and
online services. Enterprise Architect
requires an OpenID server that supports
the 'OpenID Connect' standard and is able
to return a unique user identifier in the
'user_info' request. This user identifier
will be matched to a local model user.
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Single Sign-On (SSO) Options

These options are available from Enterprise Architect
Release 14.1.

After enabling SSO there are two main options that can be
set:

Restrict access to Windows and OpenID user only·

Automatically create or modify Windows or OpenID·

users

These options are detailed here.

Access

Ribbon Configure > Security > Users

Restrict access to Windows and OpenID
users only

Enabling this option will stop local model users from being
able to log in to the model. Only users validated through
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either Windows or OpenID SSO will be able to log in.

An exception is made for local users who have the 'Security
- Manager Users' permission set. This allows a local
administrator to still have access and be able to update or
modify the SSO settings.

Automatically create or modify Windows or
OpenID users

Enabling this option will allow the model to create new
users derived from the trusted SSO source. Users will be
assigned local group permissions based on the groups linked
to the SSO provider. Existing users will be assigned to or
revoked from linked groups based on their SSO groups.

Notes:

A new user that is not in any SSO groups that are linked·

to model groups, will not be automatically created

An existing user that is not in any SSO groups that are·

linked to model groups, will not be logged in

An existing user's individual permissions will not be·

modified automatically

An existing user will not be removed from a group that is·

not linked to an SSO group

Note
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It is recommended that you always keep a local model
administrator account (with a strong password) to allow
recovery in the case the SSO authentication fails (for
example, if the OpenID server is offline or mis-configured)
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Configure OpenID

This feature is available from Enterprise Architect Release
14.1.

To enable users to log in with an OpenID account, an
OpenID server that supports the 'OpenID Connect' standard
must be available.

These settings will be used by Enterprise Architect, Pro
Cloud Server, and WebEA.

Access

Ribbon Configure > Security > Users > Accept
OpenID Authentication
Configure > Security > Users >
Configure OpenID

Settings
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Field Action

OpenID URL Enter the full path to the discovery URL
of the OpenID server, minus the standard
"/.well-known/openid-configuration"
(this will be appended automatically).
Include the protocol (http:// or https://),
and the port if running on a non-standard
port (that is, not 80 or 443).
You should be able to copy the address
with the
"/.well-known/openid-configuration"
appended and open it in a browser and
see a text-based response.
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Press the Test button now and click on
'Login with OpenID' to open a browser to
the correct address. If the URL is
incorrect or OpenID returns a malformed
configuration response, an error message
will display.

Client ID OpenID needs to be configured with a
client to allow Enterprise Architect to use
its services. Enter the Client ID here.

Client Secret
- (optional)

Some OpenID clients require a Client
Secret to further secure the requests. If
the client requires a secret, enter it here. It
will be saved as an encrypted value.

Scope Enter the OpenID scopes required to
return a response with the required
information. A scope of 'openid' is
mandatory according to the standard.
Other common scopes include 'profile' or
'email'.

Claim to
Match to
Local User

Enter the claim that will be returned when
querying the OpenID 'user_info' that will
be used to match the OpenID user to an
existing model user login.
'Claims' are information fields that the
OpenID server is claiming are true about
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the authenticated user. Most OpenID
servers allow this to be customized so it
can be set up to return a claim field
specifically for use with Enterprise
Architect, if desired.
Note: The only claim that is guaranteed
to be unique for a user is 'sub'. This is the
'subject' of the claim. For new models
this would be a good default setting in the
claim field.
For existing models where there are
already users in the model that should be
matched to OpenID, it is recommended to
use a 'username' field of some sort. Either
the standard 'preferred_username', 'email'
(if email is used, it is recommended that
email validation is enabled) or a custom
'EA username' would make sense in this
situation.
If using a claim other than 'sub' it is up to
the maintainer of the OpenID server to
ensure that the claim is unique and
secure, and to ensure the claim can not be
edited by the user.

Claim to
Match to
Local Groups

This option is used if the additional
setting 'Automatically create or modify
Windows or OpenID users' is enabled. It
is not used otherwise. See the Single
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Sign-On (SSO) Options Help topic.
Enter the claim that will be returned when
querying the OpenID 'user_info' that will
be used to match the OpenID user's
groups to existing model groups.
'Claims' are information fields that the
OpenID server is claiming are true about
the authenticated user. Most OpenID
servers allow this to be customized so it
can be set up to return a claim field
specifically for use with Enterprise
Architect, if desired.
The OpenID standard does specify
anything in regards to user groups. Some
OpenID servers have this functionality
built in but still need to be enabled so the
groups can be returned in the 'user_info'.
The returned groups can be either a single
JSON field or a JSON array containing
multiple group names.

Testing Connection

Once all fields are completed, press the Test button. A
window will pop up with a 'Log in to OpenID' button. Click
the button to open a web browser to the OpenID server

(c) Sparx Systems 2018 Page 106 of 260



User Guide - Team Support 21 December, 2018

authentication page.

Provide valid credentials and allow Enterprise Architect
access to the OpenID server account (this might or might
not be required depending on the OpenID environment).

If successful, the browser should close automatically and
Enterprise Architect will show a success window with the
OpenID user's details, including any groups returned and the
model groups they are linked to.

Example of a valid 'user_info' response

This is an example response for a 'KeyCloak' OpenID
server.

Claim to Match to Local User: username

Claim to Match to Local Groups: groups

{

   "sub": "6da812c4-8f2c-400f-b602-13bab1d4605e",

   "address": {},

   "name": "Example Person",

   "groups": [

       "EA Special Users",

       "EA Administrators"

   ],

   "given_name": "Example",

   "family_name": "Person",
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   "email": "eperson@example.com",

   "username": "eperson"

}
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Import User IDs From Active Directory

Whilst you can define each of your model users individually
and specifically for Enterprise Architect security, you can
also import your Windows user IDs from Windows Active
Directory and use those as the security user IDs with
Windows Authentication. If you set up your security user
IDs in this way, when a user opens the model the system
checks the users database for their Windows ID and, if it
matches, automatically logs the user in without prompting
for a password.

As a pre-requisite, you create an appropriate user group into
which to import the user IDs; you can also use this to assign
appropriate permissions to the user IDs as a whole.

Access

Ribbon Configure > Security > Users

Import user IDs from Windows Active
Directory

Ste Action
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p

1 On the 'Security Users' dialog do not complete any
user details fields. Instead, select the 'Accept
Windows Authentication' checkbox and click on the
Import button.
The 'Import Users' dialog displays.

2 In the 'Security Group' panel, select the checkbox
against the appropriate security group to contain the
imported user IDs.

3 Click on the Add button.
The 'Select Users' dialog displays.

4 If the 'Select this object type' field has not defaulted
to 'Users':

Click on the Object Types button; the 'Object1.
Types' dialog displays
Select the checkbox against 'Users' (the type of2.
object to import from the Active Directory).
Click on the OK button to return to the 'Select3.
Users' dialog.

5 Click on the Locations button.
The 'Locations' dialog displays.

6 Browse for and select the location to import from,
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within the Active Directory.
Click on the OK button to return to the 'Select Users'
dialog.

7 In the 'Enter the object names to select' field, either:
Type in the user IDs individually (click on the·

examples link to see examples of the correct
formats) and go to step 13, or
Click on the Advanced button to search for IDs;·

the 'Select Users' dialog redisplays showing a
'Common Queries' tab

8 In the 'Name' and 'Description' fields, type any
characters or text that help identify the IDs you are
searching for.

9 In the 'Starts with' field, click on the drop-down
arrow and, if necessary, select a different qualifier.

10 Optionally, to further filter the IDs to search for,
select the 'Disabled accounts' or 'Non-expiring
password' checkboxes, and/or select a value in the
'Days since last logon' field.

11 Click on the Find Now button to initiate the search,
and to display a list of IDs in the bottom panel of the
dialog.
You can vary the types of information shown here
by clicking on the Columns button and selecting the
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column headings to display, then dragging the
column titles into the sequence you prefer.

12 When you have identified the IDs to import, click on
a required ID (or press Ctrl or Shift while you click
to select several) and click on the OK button.
The 'Select Users' dialog redisplays, with the
selected ID or IDs listed in the 'Enter the object
names to select' field.

13 Click on the OK button to redisplay the 'Import
Users' dialog with the selected users' names listed in
the 'Users' panel.

14 Click on the Import button to add the user IDs to the
'Security Users' dialog.

15 Click on a user ID to populate the dialog fields with
the user ID details.
You can also set group membership and/or single
permissions here.

Notes

You must have 'Security - Manage Users' permission to·

maintain users; the initial Admin administrator and
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Administrators group automatically have this permission

As a security measure, the Windows Authentication is·

automatically deactivated if the project file is moved to a
different location; once the file has been relocated, you
can toggle the 'Accept Windows Authentication' checkbox
to reactivate Windows Authentication

Enterprise Architect generates random passwords for·

Windows user IDs; however, if necessary you can assign
a new password to an imported user ID
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List of Available Permissions

In the Corporate, Unified and Ultimate editions, if security
is enabled, users can update information if they have the
appropriate access permissions for the data update tasks for
that type of data. The tasks that a user can perform with
each access permission are listed here.

Some permissions take precedence over others. For
example, if a user has 'Use Version Control' permission,
they can modify model elements on import even if they do
not have 'Update Element' permission.

Permissions

Permission Enables the user to

Administer
Database

Compact and repair a project database.

Admin
Workflow

Develop and manage workflow scripts.

Audit
Settings

Change the audit settings in the 'Audit
Settings' dialog.

Audit View Enable auditing and display data in the
'Audit View' and 'Audit History' tab.
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Baselines -
Manage

Create, delete, import and export
Baselines.

Baselines -
Restore
model

Merge data into the project model from a
Baseline or XML file.

Change
Password

Change your own password.

Check Data
Integrity

Check and repair project data integrity.

Configure
Datatypes

Add, modify and delete datatypes.

Configure
External Data
Sources

When importing data from an external
tool you need this permission to
configure the default mapping values that
determine what type of local elements are
created in Enterprise Architect when the
data is imported.

Configure
Images

Configure alternative element images.

Configure
Packages

Configure controlled Packages and
Package properties.
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Configure
Project
Prerequisites

Set up the:
MDG Technologies that are·

mandatory, permitted or blocked for
the project
Minimum version and build of·

Enterprise Architect required for the
model

Configure
Resources

Create and manage:
Resources window items: document·

templates, Design Patterns, profiles and
favorites
Available Project resources·

CSV Specifications·

Configure
Stereotypes

Add, modify and delete Stereotypes.

Configure
Version
Control

Set up Version Control options for the
current model.

Edit Scripts Add, edit, delete and regroup model
scripts.

Export XMI Export a model to XMI. Also required for
CSV Import and Export, and for creating
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and editing CSV Specifications.

Generate
Documents

Generate document and web reports from
model Packages.

Generate
Source Code
and DDL

Generate source code and DDL from a
model element, and synchronize code
against model elements if it already
exists.

Import XMI Import a model from XMI. Also required
for CSV Import and Export, and for
creating and editing CSV Specifications.

Lock
Elements

Lock an element or Package.

Manage
Diagrams

Create new diagrams, copy and delete
existing diagrams, and publish a diagram
as a Pattern.

Manage
Glossary

Create, edit and delete glossary items in
the Project Glossary.

Manage
Issues

Update and delete model Issues.

Manage
Project

Add, update and delete Project Calendar
events; those without this permission can
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Calendar view calendar items.

Manage
Project
Settings

Update and manage project-wide settings
including:

The default element font size and type·

for the model
The model default diagram·

Resource metrics, risks, efforts and·

allocation
Auto-created Diagram Image and·

Image Map
WebEA URL and Index·

Manage
Reference
Data -
Update

Update and delete reference items.

Manage
Replicas

Create and synchronize replicas.

Manage
Tests

Update and delete Test records.

Reverse
Engineer
from DDL
and Source

Reverse engineer from source code or
ODBC, and synchronize model elements
against code.
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Code

Run Scripts Run and debug a script.

Security -
Enable/Disab
le

Disable user security in Enterprise
Architect.

Security -
Manage
Locks

Delete element locks set by other users.

Security -
Manage
Users

Maintain users, groups and assigned
permissions.

Spell Check Spell check a Package and set the spell
check language.

Transfer Data Transfer model between different
repositories.

Transform
Package

Perform transformations of Packages and
elements.

Update
Diagrams

Update diagram appearance, properties
and layout, including on the 'Page Setup'
dialog.
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Update
Elements

Save model changes (including deletions)
for elements, Packages, and relationships.

Use Version
Control

Check files in and out using Version
Control.

View Locks Display all locks that have been set in the
model.

Visibility
Level Admin

Assign Visibility Levels to Packages in a
model configured for Visibility Levels,
on Oracle 8+ and Microsoft SQL Server
2016 databases, hosted on the Cloud by
the Pro Cloud Server.
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View All User Permissions

When a user has been set up on the system with their
appropriate access permissions, you can periodically
monitor the list of permissions to verify what they are able
to do and check that their profile is up to date. The access
permissions shown as selected are derived from their
individual profile and from their membership of security
groups.

Access

Ribbon Configure > Security > Users

Display the permissions assigned to a user ID

Ste
p

Action

1 On the 'Security Users' dialog, select the user ID in
the 'Users' list so that the details display in the 'User
Details' panel.
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2 Review the list of permissions in the 'User
Permissions' panel. The user has all access
permissions for which the checkbox is selected, and
does not have the permissions for which the
checkbox is clear.

Notes

You must have 'Security - Manage Users' permission to·

maintain users; the initial Admin administrator and
Administrators group automatically have this permission

On this dialog you can select and deselect checkboxes in·

the 'User Permissions' panel to edit the user's individual
access permissions, but you cannot change permissions
assigned via the User Groups; click on the Save button to
save any changes
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View and Manage Locks

When security is enabled, users lock and unlock model
elements in order to work on them, which can require
monitoring and control. You can periodically view and, if
necessary, delete the active locks placed on elements by
users.

Access

Ribbon Configure > Security > Locks

Manage user locks

Ste
p

Action

1 On the 'Manage Locks' dialog, in the 'View Locks
For' panel, click on the radio button for the type of
lock to view.

All·

Groups Only·

Users Only·
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Locks of the selected type are listed in the 'Active
Locks' panel.

2 To remove a lock, click on it and click on the Unlock
Selected button.
You can select (and deselect) multiple locks by
pressing Ctrl as you click on each one, or Shift as
you click on the last lock in a range.
You can also select all locks in the list by clicking on
the Select All button, and clear that selection by
clicking on the Select None button (or by clicking
off the list).

3 When you have finished reviewing the locks, click
on the Close button to close the dialog.

Notes

You must have 'Security - Manage Locks' permission to·

delete user locks; the initial Admin administrator and
Administrators group automatically have this permission

You can view locks without the 'Manage Locks'·

permission, so that you can contact the lock owner if
necessary

The 'Manage Locks' dialog does not currently show any·

Full locks set in the model
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If you want to display the resulting information in a more·

readable layout, you can resize the dialog and its columns
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Password Encryption

In releases of Enterprise Architect prior to 7.1, Security
Administrators of projects on SQL Server or Oracle
repositories can encrypt the password used to set up the
connection between Enterprise Architect and the repository.
The system user does not have the real password, thereby
preventing them from accessing the repository using other
tools such as Query Analyzer or SQLPlus.

For password encryption for all repositories at and beyond
release 7.1, you provide the connection but protect the
password using model shortcuts.

Access

Ribbon Configure > Security > Administer >
Encrypt Password

Encrypt a repository password

Ste
p

Action
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1 In the 'Password' field, enter the password to access
the repository.
The 'Encrypted' field displays the modified password
to be provided to users.

2 Instruct users to connect Enterprise Architect to the
repository using the encrypted password prefixed
with $$.

Notes

Do not click on the Test Connection button as it can cause·

an error with encrypted passwords

For SQL Server repositories, you must enter the Initial·

Catalog details from the 'All' tab of the 'Data Link
Properties' dialog
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Change Password

It is recommended that users of any computer system
change their passwords - or have them changed - at regular
intervals. When security is enabled in Enterprise Architect,
users can change their own passwords or, if the user is
unable or not authorized to do this, a Security Administrator
can set or change the user's password.

Access

Ribbon Configure > Security > Administer >
Change Password (User)
Configure > Security > Administer >
Users (Administrator)

Other (Top right corner of screen) >

 > Change Password

User - Change your own user password
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Ste
p

Action

1 On the 'Change Password' dialog, in the 'Enter old
password' field, type your current password.

2 In the 'New password' field, type your new
password.
This can be any number of characters in length.

3 In the 'Retype new' field, type your new password
again, for confirmation.

4 Click on the OK button.
The Password Changed message displays.

5 Click on the OK button to clear the message.
Use your new password next time you log in.

Administrator - Set or change any user's
password

Ste Action
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p

1 On the 'Security Users' dialog, in the 'Users:' panel,
click on the user's name.
The user's details display in the dialog fields.

2 Click on the Change Password button.
The 'Change Password' dialog displays.

3 In the 'New password' field, type the user's new
password.
This can be any number of characters in length.
You do not have to enter the user's current password.

4 In the 'Retype new' field, type the user's password
again, for confirmation.

5 Click on the OK button.
The Password Changed message displays.

6 Click on the OK button.

7 By secure means, notify the user of their new
password.
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Notes

A user must have 'Change Password' permission to·

change their own password; the initial Admin
administrator and Administrators group automatically
have this permission

A Security Administrator must have 'Security - Manage·

Users' permission to change other users' passwords; the
initial Admin administrator and Administrators group
automatically have this permission
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Lock Model Elements

If you need to set a lock on a Package, element or diagram,
or clear that lock, you can do so from either the Project
Browser or - for an element or diagram - from within a
diagram. You follow one of three procedures, depending on
whether you are:

Locking an element or diagram under the 'User/Group·

Locking' security policy

Locking a Package under the 'User/Group Locking'·

security policy

Locking an element or diagram under the 'Require User·

Lock to Edit' security policy

You can also lock all elements, diagrams or Packages in a
selected group, at once. The procedures are the same as for
locking individual objects, subject to the comments
provided here.

Notes

You must have 'Lock Elements' permission to lock an·

element or diagram

Locking multiple objects together
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You can select multiple objects in the Project Browser, and
lock them at the same time. The multiple objects should be
of the same type; that is, several Packages OR several
diagrams OR several elements. The selected objects must
also have the same parent and therefore be peers.

When you have selected the objects to lock, right-click on
one of them and:

Under 'User/Group Locking' policy, select:·

    - Lock Element(s)
    - Lock Diagrams(s) or
    - Lock Package(s)

Under 'Require User Lock to Edit' policy, select:·

    - Apply/Release User Lock(s)

If there is a locking conflict with any item to be locked - for
example, a different user or group has locked the individual
item - that item is ignored by the locking process and a
warning error is added to the System Output window; this
avoids multiple popup dialog warnings.
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Lock Objects Under User/Group
Locking

Under the User/Group Locking security policy, if you need
to set or release a lock on an element or diagram, you can do
so from either the Project Browser or from within the
diagram.

Access

Ribbon Design > Diagram > Edit > Lock     (on·

selected diagram)
Design > Element > Edit > Lock     (on·

selected element)

Context
Menu

Select one of:
Project Browser | Right-click on·

diagram | Lock
Project Browser | Right-click on·

element | Lock
Project Browser | Select a Package,·

diagram or element and press
Ctrl+Shift+L
On a diagram | Right-click on diagram·

background | Lock Diagram
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On a diagram | Right-click on element |·

Lock Element      or
On a diagram | Select an element and·

press Ctrl+Shift+L

Set a lock on an element or diagram

Ste
p

Action

1 On the 'Lock Element' or 'Lock Diagram' dialog, in
the 'Lock Type' panel, select the radio button for the
required option:

'No lock' - do not set a lock on this object; clear·

any existing lock that you have set, or clear any
Full lock that other users have set
'Full lock' - lock this object so that no-one can edit·

it without specifically clearing the lock
'User lock' - lock this object so that only you can·

make further edits; other users cannot unlock or
edit the object
'Group lock' - lock this object so that any member·

of the specified group can edit the object; other
users cannot unlock or edit the object
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2 If you have selected the 'Group lock' option, in the
'GroupID' field click on the drop-down arrow and
select the group containing users that can edit the
object.
The 'GroupID' drop-down list only includes groups
that you are a member of.

3 Click on the OK button.

Notes

To check whether the project security is in User/Group·

locking mode, select 'Configure > Security > Administer';
the 'Require User Lock to Edit' option should be
deselected

You must have 'Lock Elements' permission to lock an·

element or diagram

If the item already has a lock, only the corresponding lock·

option and the 'No lock' option are highlighted; you have
to release the lock in order to set a different type of lock

If a diagram is locked and you select an element on it, the·

element border displays in red, indicating that you cannot
move it or resize it

If an element is locked and you click on it on a diagram,·

the element border displays in black; you can display the
properties but not change them
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If you select the 'Full Lock, no-one may edit' option, a red·

exclamation mark displays against the object in the
Project Browser

If you select the 'User Lock, locking user may still edit' or·

'Group lock, locking group may still edit' options, a blue
exclamation mark displays against the object in the
Project Browser; other users see a red exclamation mark
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Lock Packages Under User/Group
Locking

If, in User/Group locking mode, you want to lock or unlock
the contents of a Package, you can do so in a single
operation. You can set the lock on the entire contents
(including child Packages), just on the top-level Package
content, or just on the elements or diagrams in the Package.

Access

Ribbon Design > Package > Edit > Lock Package
(on selected Package)

Context
Menu

Project Browser | Right-click on Package
| Package Control | Lock Package

Keyboard On selected Package, Ctrl+Shift+L

Lock or Unlock a Package

Ste
p

Action
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1 In the 'Lock Type' panel, select the appropriate radio
button for the lock to apply:

No lock - do not set a lock on this Package; clear·

any existing lock that you have set, or clear any
Full lock that other users have set
Full lock - lock this Package so that no-one can·

edit it without specifically clearing the lock
User lock - lock this Package so that only you can·

make further edits; other users cannot unlock or
edit the Package
Group lock - lock this Package so that any·

member of the specified group can edit the object;
other users cannot unlock or edit the Package

2 If you have selected the 'Group lock' option, in the
'GroupID' field click on the drop-down arrow and
select the group containing users that can edit the
object.
The 'GroupID' drop-down list only includes groups
that you are a member of.

3 The 'What to Process' checkboxes default to selected
to also lock:

Elements and/or diagrams in the Package·

The contents of child Packages (that is, the whole·

branch)
If you want to exclude any type of Package content
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from the change in lock status, deselect each
appropriate checkbox.

4 Click on the OK button to apply the lock.

Notes

To check whether the project security is in User/Group·

locking mode, select 'Configure > Security > Administer';
the 'Require User Lock to Edit' option should be
deselected

You must have 'Lock Elements' permission to lock a·

Package

If the Package is already locked, only the corresponding·

lock option and the 'No lock' option are highlighted; you
have to release the lock in order to set a different type of
lock

If you select the 'Full Lock, no-one may edit' option, a red·

exclamation mark displays against the Package in the
Project Browser

If you select the 'User Lock, locking user may still edit' or·

'Group lock, locking group may still edit' options, a blue
exclamation mark displays against the Package in the
Project Browser; other users see a red exclamation mark
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Lock Objects Under Require User Lock
to Edit

In the Require User Lock to Edit security mode, if you want
to edit one or more of the diagrams or elements in a
Package, you must set a User Lock on either the specific
objects or the Package that contains them. You can set or
release the lock from either a diagram or the Project
Browser. Once you have set a lock, only you or the Security
Administrator can release it again; no other user can release
your locks.

Access

Ribbon Design > Package > Edit > Lock·

Package     (on selected Package)
Design > Diagram > Edit > Lock     (on·

selected diagram)
Design > Element > Edit > Lock     (on·

selected element)

Context
Menu

Select one of:
Project Browser | Right-click on·

Package | Package Control |
Apply/Release User Lock, or
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Project Browser | Right-click on·

diagram | Apply/Release User Lock, or
Project Browser | Right-click on·

element | Apply/Release User Lock, or
Project Browser | Select a Package,·

diagram or element, then press
Ctrl+Shift+L, or
On a diagram | Right-click on·

background | Apply/Release User
Lock, or
On a diagram | Right-click on element |·

Apply/Release User Lock, or
On a diagram | Click on an element,·

then press Ctrl+Shift+L

Set or clear a user lock in Require User Lock
to Edit security mode

Ste
p

Action

1 On the 'Set User Lock' dialog, click on either the:
'Apply User Lock' radio button to set the lock or·

'Release User Lock' radio button to clear the lock·

(c) Sparx Systems 2018 Page 142 of 260



User Guide - Team Support 21 December, 2018

2 For a Package, if you want to also lock all child
Packages, select the 'Include Child Packages'
checkbox.
If any elements in the Package tree are locked by
other users, a list of elements that couldn't be locked
displays.

3 Click on the OK button.
The system locks or unlocks:

The selected element·

The selected diagram and the diagram settings for·

elements on the diagram (not the elements
themselves), or
The Package and all elements and diagrams in the·

top level of the Package

Notes

To check whether the project security is in Require User·

Lock to Edit mode, select 'Configure > Security >
Administer'; the 'Require User Lock to Edit' option should
be selected

You must have 'Lock Elements' permission to lock a·

Package

When you set a user lock, a blue exclamation mark·
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displays against the object or objects that are locked; other
users see these as red exclamation marks
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Locked Element Indicators

When a user sets a lock on an item through User Security,
the lock status of the item is indicated in the Project
Browser by a marker against the item - a red or blue
exclamation mark - as shown:

These indicators also display against the locked element on
any diagram in which the element is represented.

The effect of the lock and the meaning of the status marker
depend on the security policy applied to your project.
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Require User Lock to Edit

Marker Meaning

No marker There is no lock, the item is not editable,
but any user can now apply a user lock to
edit the item.

Blue
exclamation
mark

You have applied a user lock and can edit
the item; no other user can release the
lock, set their own lock or edit the item.

Red
exclamation
mark

Another user has applied a user lock, and
you cannot release the lock, set your own
lock or edit the item.
You can find out which user has locked
the item.

User/Group Lock

Marker Meaning

No marker There is no lock, the item is editable, but
any user can now apply a user or group
lock.
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Blue
exclamation
mark

The item has a lock set by you or a group
including your user ID as a member, and
you can edit the item.

Red
exclamation
mark

The item has a lock set by another user,
or a group of which you are not a
member; you cannot edit the item.
You can find out which user has locked
the item.
The red exclamation mark also indicates
that you or another user has set a full lock
on the item. Any user can clear that lock.

Notes

If a diagram is locked and you select an object on it, the·

object border displays in red; this indicates that you
cannot change the location or size of the object on the
diagram
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Identify Who Has Locked An Object

When you are working in your model, you might find that
you are unable to update an element, diagram or Package. If
you cannot update any object, this might mean that you do
not have the access permissions to update diagrams or
elements. However, if the object in the Project Browser has
a red exclamation mark next to it this indicates that either
another person has placed a user lock or group lock on the
object, or you or another user have put a full lock on the
object.

You can quickly establish if the lock is a full lock (which
you can remove) or which user has set a user or group lock.

Access

Context
Menu

Project Browser | Right-click on·

Package | Package Control | Lock
Package
Project Browser | Right-click on a·

diagram | Lock Diagram
Project Browser | Right-click on·

element | Lock
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Identify the lock holder

Ste
p

Action

1 In the Project Browser, right-click on the diagram,
Package or element that has a red lock indicator, and
select the appropriate 'Lock' option (for a Package,
the option is in the Package Control submenu).
If the lock is:

A Full lock, the 'Lock <object>' dialog displays,·

and you can delete the lock and set your own
A user lock or group lock, a message displays·

showing the user ID of the person or group who
currently holds the lock on that item; click on the
OK button to close the dialog

Notes

You must have Lock Elements permission to lock or clear·

the lock on a Package, element or diagram
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Manage Your Own Locks

As you are working in your model, you might set user locks
on elements, diagrams and Packages so that you can work
on them and protect that work while it is progress. Having
completed your work, you might then want to remove those
locks. You can do this on each object individually, using the
same procedure as you used to set the lock. You can also
display a list of all the locks you have set, and remove
selected locks or all locks at once. This is especially useful
when working under the 'Require user locks to edit' security
policy.

Access

Ribbon Configure > Security > Administer >
Manage My Locks

Keyboard
Shortcuts

Ctrl+Shift+L

Manage your own locks

Notes
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You must have 'Lock Elements' access permission to set·

user locks on modeling elements, but you do not require
any access permission to list or clear them using this
procedure

Ste
p

Action

1 All the locks that you have set in the model are listed
on the 'My Locks' dialog.
This dialog does not show Full locks or Group locks.

2 If you intend to clear locks, either:
Select a single lock you intend to clear·

Press Ctrl or Shift as you select a number of locks·

or a range of locks respectively, to clear
Click on Select All to select all of your locks, or·

Click on Select None to clear your selection, if·

you have made an error

3 If you have selected locks to clear, click on the
Unlock Selected button.
The objects that were locked are now unlocked.
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Project Calendar

The Project Calendar provides a project management
overview in calendar format of the deployment of resources,
timeframes for tasks, and upcoming project events such as
meetings and milestones. The calendar displays in the
Diagram View workspace, consisting of a:

Calendar panel, displaying months of the year·

Diary panel sectioned into days or weeks·

Toolbar at the top of the window, which enables you to·

define what information is displayed and how it is
formatted

Access

Ribbon Start > Collaborate > Calendar

Features

Screen area Description

Calendar
Panel

The calendar panel, when viewed
normally on the screen, displays a
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calendar of six months that by default
includes the current month.
By closing or reducing other panels on
the screen, and depending on the size of
your screen, you can show the months for
a period of up to 3 years and six months.
You can review data for up to several
decades into the past, if such data has
been recorded, and plan ahead for up to
several decades into the future; to display
future or past months, either:

Click on the arrows in the names of the·

months on the left and right of the top
row of months, or
Click and hold the mouse on the name·

of a month so that a list of months and
years displays, then move the mouse
forwards to scroll up the list or
backwards to scroll down the list; when
you reach the required month, ensure
that it is highlighted and release the
mouse button

On the calendar, today's date has a red
border; if you have scrolled the calendar
so that today's date is not shown, click on
the second icon in the toolbar ( ) to
position the current month in the top left
of the calendar with today's date
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highlighted.

Diary Panel The 'Diary' panel displays a set of day
fields, each of which can contain one or
more markers for an event or task.
The content of the display is determined
by the selections you make in the toolbar,
and principally by the object type you
select from the first drop-down field:

Project Calendar·

Allocated Resources·

Project Tasks·

The structure of the display depends on
the period you want to review, specified
using the icons on the toolbar:

1 day (Project Calendar only)·

5 days (Mon - Fri) (Project Calendar·

only)
7 days (Mon - Sun)·

31 days·

However, in the 'Calendar' panel you can
highlight specific periods of between 1
and 7 days (Project Calendar only) and
14, 21, 28, 35 and 42 days, to display just
those periods in the 'Diary' panel.
If you select a period of between 1 and 7
days, each day is divided into one hour
time intervals; you can adjust the time
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intervals for these periods, using the
toolbar.
For the current day, the current time is
also highlighted.
Also, if you click on today's date in the
'Calendar' panel the 'Diary panel' changes
to show the shortest period (7 days or 1
day) for the object type, again with
adjustable time intervals for the times of
day.
For displays of 7 or more days, you can
scroll up or down to display the
information for earlier or later dates; if
you scroll away from today's date, you
can return to it by right-clicking
anywhere on the display and selecting the
'Show Today' option (not Project
Calendar).

Toolbar The toolbar options modify what is
displayed on the 'Diary' panel, and help
you to add certain kinds of information.
The icons and fields in the toolbar, from
left to right, have these functions:

Add New <object> - enables you to·

create a new record for an event or task
Assign Resource - for Allocated·

Resources, enables you to assign a new
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resource to the task
Show Today - re-focuses the 'Diary'·

panel and 'Calendar' panel on today's
date, for any object type
1, 5, 7, 31 - sets the number of days·

displayed in the 'Diary' panel
First drop-down - identifies the type of·

information to display: Calendar
events, allocated Resources, or Tasks
Second drop-down - identifies the type·

or characteristic of object to filter for
(and depends on the value selected in
the first field)
Third drop-down - for Allocated·

Resources, identifies the element type
to filter for
Options:·

    - Configure Event Subtypes -
displays the 'Configure Subtype' dialog,
       which you use to define categories
of event to record on the Calendar
    - Time Scale - where the display
includes times of day; enables you to
       reset the time interval
    - Show End Time - for the Project
Calendar, where the times of day
       are NOT shown and an event
occurs within one day, this shows or
       hides the time at which the event
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finishes (the start time displays
       automatically)
    - Show Time As Clocks - toggle
between showing start and end times
        in digital format and as a clock
face
    - Compress Weekend Days - in
31-day format, toggle between showing
       Saturday and Sunday as separate
fields and a pair of half-fields
    - Show ToolTips - toggle between
showing and hiding mouse
       roll-over tool-tips

Notes

The Project Calendar is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

In the Lite edition of Enterprise Architect, you can view·

Calendar entries but not change them
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Calendar

Project Calendar is a display mode of the project Calendar
facility. In Project Calendar mode, the 'Diary' panel shows a
selected period of time containing flags for each event that
takes place in or through that period. These events can be,
for example, meetings, staff absences or commitments,
product releases or public holidays.

You can customize the range of events that you record,
using the 'Configure Subtype' dialog.

Access

Ribbon Start > Collaborate > Calendar > Project
Calendar

Record an event in the Project Calendar

Ste
p

Action

1 Double-click on the required day, or the first day in a
longer period.
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The 'Project Event' dialog displays.

2 In the 'Subject' field, type the name of the event.

3 If the event is to take place at a specific place, in the
'Location' field type the name of the place or room.

4 In the 'Category' field, click on the drop-down arrow
and select the appropriate categorization:

Event (such as an external trade show, or internal·

presentation)
Meeting (whether internal or external)·

Milestone/Objective (such as a product test or·

release)
People (an absence or commitment of a specific·

staff member)

5 If the event is likely to occupy one complete day,
select the 'All day event' checkbox; this:

Places the event icon at the top of the day field in·

the Diary, above any time sections
Hides the time sections of the 'Start time' and 'End·

time' fields

6 In the Start time and End time fields, specify the start
and end dates and/or times of the event.
In the date section of each field, either:

Click on the drop-down arrow to display the·
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current month and select the month and date, or
Click on the 'spin' arrows to roll the date forwards·

or backwards by one day at a time

In the time section of each field, click on the hour or
minute components (which are separate) and either:

Type in the required time or·

Click on the 'spin' arrows to roll the time·

backwards or forwards

7 In the 'Event Type' field, click on the drop-down
arrow and select an appropriate type label for the
event; the options change depending on the value
you selected for the 'Category' field.
This provides the fill color for the event icon, as
indicated by the fill box next to each option.

8 In the 'Defined as' field, click on the drop-down
arrow and select the indicator for whether the event
is internal or external to your organization.

9 If the event consists of a telephone call, select the
'Phone Call' checkbox.

10 In the description field, type any notes required on
the event; these display in the mouse roll-over
tool-tip for the event on the 'Diary' panel.
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11 If this event repeats at regular intervals, click on the
Recurrence button and complete the 'Event
Recurrence' dialog.

12 Click on the OK button to save the event and display
it on the Calendar.

Define a recurring event

Ste
p

Action

1 In the 'Start' and 'End' fields, specify the start and
end times of the event; click on the hour or minute
components (which are separate) and either:

Type in the required time or·

Click on the 'spin' arrows to roll the time·

backwards or forwards

2 In the 'Duration' field, click on each of the day(s),
hours and minutes portions and either type or 'spin'
to the required value.
The hours and minutes portions are linked to the
'Start' and 'End' fields, so that:

As you edit the 'Start' field or the 'Duration' field,·
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the 'End' field adjusts to maintain the duration
relative to the start time
As you edit the 'End' field, the 'Duration' field·

changes to match the difference between the start
and end times

3 In the 'Recurrence pattern' panel, select the
appropriate radio button for the frequency of the
event.
As you select the radio button, the fields on the right
of the panel change to further define when the event
recurs.

4 Select the appropriate radio buttons and field values,
with this guidance:

Daily can be every 1, 2, 3, 4, 5 or 6 days, or every·

day of the working week
Weekly is on one or more specific days of the·

week, the events being separated by a period of
between 1 and 51 complete weeks
Monthly can be on a specific date or a specific day·

of the month, the events being separated by a
period of between 1 and 11 complete months
Yearly can be on a specific date or a specific day·

of a specific month

5 In the 'Range of recurrence' panel, in the 'Start' field,
specify the date on which the event cycle begins.
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Click on the day, month and year components
(which are separate) and either:

Type in the required value or·

Click on the 'spin' arrows to roll the date·

backwards or forwards

6 Select the appropriate radio buttons to indicate that
the recurrence cycle:

Has no defined end point·

Ends after a specific number of occurrences of the·

event (type in the number)
Ends by a specific date (enter the date)·

7 Click on the OK button, and again on the 'Project
Event' dialog.
The event icon displays at all points in the Calendar
where it is scheduled to occur, as defined in the
'Event Recurrence' dialog; the recurrence is indicated
by a graphic depicting two recirculating arrows.

8 If the recurrence is no longer required:
Double-click on the icon for any occurrence of the·

event, to display the 'Project Event' dialog
Click on the Recurrence button to display the·

'Event Recurrence' dialog
Click on the Remove Recurrence button; the·

'Event Recurrence' dialog closes
Click on the OK button; the 'Project Event' dialog·
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closes
Only the first occurrence of the event remains in the
Calendar.

Notes

The Project Calendar is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

In these editions, if security is enabled you must have·

'Manage Project Calendar' permission in order to create,
update or delete Project Calendar events; if security is not
enabled, you can change data without this permission

In the Lite edition of Enterprise Architect, you can view·

Calendar entries but not change them

You can transport a calendar of defined events between·

projects, using the 'Configure > Model > Transfer >
Export Reference Data' and 'Import Reference Data'
ribbon options
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Configure Event Subtypes

The 'Configure Subtype' dialog enables you to define
additional types of event to record on the Project Calendar,
such as:

Define a new event type within a select event category·

Change an existing event type·

Delete an existing event type·

Access

Ribbon Start > Collaborate > Calendar :  |
Configure Event Subtypes

Manage the event types for your project

Ste
p

Action

1 On the 'Configure Subtype' dialog, in the 'Category'
field, click on the drop-down arrow and select the
appropriate category for the event.
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2 Click on the 'Type' field and type a suitable name for
the event type (or select an existing event from the
list under the 'Category' field).

3 In the 'Color' field, click on the drop-down arrow and
select or define a color for the event icon.

4 Click on the Save button to save the new or edited
event type to the list for the specified category.
Click on the New button if you are going to create
another event type.

5 If the event type is no longer required, click on the
Delete button.

6 If required, you can change the sequence of the event
types in the displayed list, using the 'Up Hand' and
'Down Hand' buttons at the bottom of the dialog.

7 Click on the OK button to close the dialog; any new
event types are available for use in the Project
Calendar.

Notes

In the Corporate, Unified and Ultimate editions of·
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Enterprise Architect, if security is enabled you must have
'Manage Project Calendar' permission in order to create or
delete Project Calendar event subtypes; if security is not
enabled, you can change data without this permission

You can transport your defined event types between·

projects, using the 'Configure > Model > Transfer >
Export Reference Data' and 'Import Reference Data'
ribbon options
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Allocated Resources

'Allocated Resources' is a display mode of the project
Calendar facility, that you can use to:

Review the allocation of resources across the project over·

a period of time

Review the status of the work assigned to those resources·

Display and edit the details of the task assigned to a·

resource

Allocate further resources to an element·

Delete a resource allocation from an element·

Create and send an email to the resource allocated to an·

element

In 'Allocated Resources' mode, the 'Diary' panel shows the
selected period of time (see the Project Calendar topic),
with at least one icon representing each element in the
project to which a resource has been allocated during that
period. If an element has more than one allocated resource,
each element:resource combination is represented
separately.

Each icon shows the element name and resource name, and
indicates the status of the assigned work with one of these
symbols:

a green square, indicating that the resource has been·

assigned the work

a green tick, indicating that the resource has completed·

the assigned work
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a red square, indicating that the resource has not·

completed the assigned work

a square divided diagonally with green and red halves,·

indicating that the assigned work is to be completed
within one working day

Typically, while the work is in progress a resource is
represented by:

An icon with a green square on the day the work is·

planned to start, and

An icon with a red square on the day the work is planned·

to finish

When the work is complete, the icons on both days display
the green tick.

Resources are initially allocated to elements through the:

Resource Allocation window, or·

'Allocated Work' tab of the Personal Tasks window·

You can then edit these allocations through either of those
windows or through the Allocated Resources Calendar
itself.

Access

Ribbon Start > Collaborate > Calendar >
Allocated Resources
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Allocate Resources

Option Action

Display/edit
details of an
allocated
resource

Either:
Double-click on any icon for that·

element:resource combination, or
Right-click on the icon and select the·

'Properties' option
The 'Assigned Resources' dialog displays,
showing the details of the assignment of
the resource to a task on the element.
This dialog has the same content, format
and functions as the Resource Allocation
window, in Item mode.

Add resource
to element

Right-click on any icon for the element
and select the 'Assign Resource to
<element name>' option.
The 'Assigned Resources' dialog displays,
showing the start and end dates both set
to the date from which you selected the
icon, and the 'Allocated Time' field set to
'1'; all other fields are blank.
This dialog has the same content, format
and functions as the Resource Allocation
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window, in Item mode.
Specify the resource and the role or task
that resource is performing, and define
the period for which the resource is
allocated to the element.

Message
Resource

Right-click on any icon for the
element:resource combination and select
the 'Message Resource <resource name>'
option.
The 'Model Message' dialog displays, on
which you create and send your message
to the resource allocated to the element.

Delete
resource
from element

Right-click on any icon for the
element:resource combination, and select
the 'Delete Resource from <element
name>' option.
A prompt displays to confirm the
deletion; click on the Yes button.
The icon and any corresponding icons for
that element:resource combination are
deleted from the calendar, and the
resource is no longer allocated to that
element.

Locate
element in
diagrams in

Right-click on any icon for the element,
and select the 'Find in all Diagrams'
option.
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which it is
used

If the element is used in only one
diagram, that diagram displays.
If the element is used in more than one
diagram the 'Element Usage' dialog
displays, listing the diagrams in which
the element occurs.
Select the required diagram and click on
the Open button to display that diagram.
This option also operates on Port and Part
Property Type Classifiers.

Locate
element in
Project
Browser

Right-click on any icon for the element,
and select the 'Find in Project Browser'
option.
The area of the Project Browser
containing the element is brought into
focus and expanded, and the element is
highlighted.

Locate
resource
allocation
start date
correspondin
g to
allocation
end date

Firstly, click on the end date icon for the
element:resource combination to
highlight it; the corresponding start date
icon is also highlighted.
If the start date icon is not in view,
right-click on the end date icon and select
the 'Show Start/End' option; the display
scrolls to show the start date and the start
date cell is highlighted.
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Locate
resource
allocation
end date
correspondin
g to
allocation
start date

Firstly, click on the start date icon for the
element:resource combination to
highlight it; the corresponding end date
icon is also highlighted.
If the end date icon is not in view,
right-click on the start date icon and
select the 'Show Start/End' option; the
display scrolls to show the end date and
the end date cell is highlighted.

Refocus
display on
today's date

Right-click anywhere on the display and
select the 'Show Today' option.
The display returns to today's date, which
is highlighted and outlined.

Notes

The Project Calendar is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

In these editions, if security is enabled you must have·

'Configure Resources' permission in order to allocate
resources to or remove resources from the Project
Calendar; if security is not enabled, you can change data
without this permission

In the Lite edition of Enterprise Architect, you can view·

Calendar entries but not change them
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As the start and end icons for a completed task are·

identical, and one-day tasks have only one icon, the
methods to show the corresponding start date or end date
for an icon are also useful to show whether the icon is for
a start or end date, or for a one-day task; alternatively,
double-click on the icon and review the allocation dates
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Project Tasks

Project Tasks is a display mode of the project Calendar
facility, that you can use to:

Review the tasks across the project over a period of time·

Review the progress of those tasks·

Create new tasks·

Display and edit the details of the task·

Allocate a resource to a task·

Delete a task·

Create and send an email to the resource assigned to a·

task

Create and send an email to the owner of the task·

In Project Tasks mode, the 'Diary' panel shows the selected
period of time (see the Project Calendar topic), with at least
one icon representing each project task scheduled during
that period. The icon represents an independent record of the
task - there are no comparisons or validations of the tasks.
Therefore you can have separate icons for the same task,
with different resources allocated or no resources allocated;
you can even have identical task records, if these serve a
purpose for you.

Each icon shows the task name and resource name, and
indicates the status of the task with one of these symbols:

a green square, indicating that the task has been scheduled·

a green tick, indicating that the task is complete·
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a red square, indicating that the task is incomplete·

a square divided diagonally with green and red halves,·

indicating that the task is to be completed within one
working day

Typically, while a task is in progress it is represented by:

An icon with a green square on the day the work is·

planned to start, and

An icon with a red square on the day the work is planned·

to finish

When the work is complete, the icons on both days display
the green tick.

Tasks can be created and managed through this view of the
Project Calendar, or the:

'Tasks' tab of the Project Status window, or·

'Project Tasks' tab of the Personal Tasks window·

Access

Ribbon Start > Collaborate > Calendar > Project
Tasks

Manage Project Tasks
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Option Action

Create a task Either:
Double-click on the date cell in which·

the task is to start, or
Right-click on the cell and select the·

'Add New Task' option, or
Click on the down-arrow next to the·

first icon in the Calendar toolbar, and
select the 'New Task' option

The 'Task Details' dialog displays,
through which you create the task.

Display and
edit a task

Either:
Double-click on the task·

Right-click on the cell and select the·

'Properties' option, or
Click on the down-arrow next to the·

first icon in the Calendar toolbar, and
select the 'Properties' option

The 'Task Details' dialog displays; if
necessary, edit the information.

Allocate a
resource to a
task

Certain tasks might not initially be
assigned to a resource, but might later
require specific assignment to finish them
off.
Open the task to edit it, click on the
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drop-down arrow in the 'Assigned' field
and select the required resource.

Delete a task Right-click on any icon for the required
task and select the 'Delete <task-name>'
option.
You are prompted to confirm the
deletion; click on the Yes button.

Create and
send a
message to
the task
owner

Right-click on any icon for the task and
select the 'Message Owner' option.
The 'Model Message' dialog displays, on
which you create and send your message
to the user who owns the task (as
identified in the 'Task Details' dialog).
If the task does not have a defined owner,
this option does not operate.

Create and
send a
message to
the resource
assigned to
the task

Right-click on any icon for the task and
select the 'Message Assigned <resource
name>' option.
The 'Model Message' dialog displays, on
which you create and send your message
to the resource assigned to complete the
task (as identified in the 'Task Details'
dialog).
If the task does not have a defined
resource, this option does not operate.
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Locate task
start date
correspondin
g to task end
date

Firstly, click on the end date icon for the
task to highlight it; the corresponding
start date icon is also highlighted.
If the start date icon is not in view,
right-click on the end date icon and select
the 'Show Start/End' option; the display
scrolls to show the start date and the start
date cell is highlighted.

Locate task
end date
correspondin
g to task start
date

Firstly, click on the start date icon for the
task to highlight it; the corresponding end
date icon is also highlighted.
If the end date icon is not in view,
right-click on the start date icon and
select the 'Show Start/End' option; the
display scrolls to show the end date and
the end date cell is highlighted.

Refocus
display on
today's date

Right-click anywhere on the display and
select the 'Show Today' option.
The display returns to today's date, which
is highlighted and outlined.

Notes
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The Project Calendar is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

In the Lite edition of Enterprise Architect, you can view·

Calendar entries but not change them
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Model Mail

The Model Mail facility provides you with the ability to
send, receive and respond to emails within the project team,
under your User Security ID either as an individual user or
as a member of a group that has a shared mail inbox. The
'Mail Inbox' tab shows all emails that you have received,
and the 'Sent Mail' tab shows all the emails you have created
and sent. Within the facility you can re-organize, forward,
delete and mark the emails, both sent and received.

This facility is available in the Corporate, Unified and
Ultimate editions of Enterprise Architect, with User Security
enabled; the mail system uses the individual and group users
defined in User Security.

Access

Ribbon Start > Collaborate > Mail

Review your Model Mail messages

Option Action
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Open a
message

Double-click on the message.
If the message contains a hyperlink, click
on the link to open or display the target
file or object.

Flag Check the flag color to establish the
significance of the message (the
meanings of the flag colors should be
defined within the project team).

Status Check for the read or unread icon; unread
message items are anyway displayed in
bold.

Sender The name of the project team member
who sent the message.

Subject The topic of the message.

Date Indicates the age of the message, whether
it was sent:

Today·

Yesterday·

This week·

This Month·

Last Month·

Older·
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Sent The exact date and time the message was
sent.

Select
Columns

Right-click on the column headings and
select the 'Field Chooser' menu option,
which enables you to add or remove
specific columns from the display.
You can also click on the column
headings and drag them across the header
bar to reposition the columns in a
different sequence.
Adding the 'To' column will display the
user account or group name that this mail
item was sent to; this column is useful to
identify whether the message was sent to
you as an individual or as a member of a
Group with a Shared Mail inbox - if you
received the message as a member of a
shared mail group, remember that your
actions on this message will also affect
all other members of this group.

Filter
Columns

You can filter the mail items listed by
displaying the Filter Bar (right-click on
the column headings and select the
'Toggle Filter Bar' option) and typing in
the value (or partial value) to filter on.
For example, if you type your group mail
account name in the filter field for the
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'To' column, you will list only those mail
items sent to the group mail address, not
those sent to you as an individual.
To clear the value of a filter field, click
on the blue cross against that field.

Reorganize
messages in
the list

Either:
Click on a column heading to toggle·

sorting of list items by this column in
ascending or descending order, or
Right-click on the column heading and·

select the 'Enable Group Box' option to
organize the messages into groups

Model Mail Toolbar Options

Option Action

Compose
Message

Open the 'Model Message' dialog,
through which you create and send a mail
message.

Delete
Messages

Delete a selected message or messages;
you are prompted to confirm the deletion.
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Reply Open the 'Model Message' dialog,
through which you create a response to
the sender of the message, which includes
a copy of the message and any earlier
messages in the thread.

Reply to All Open the 'Model Message' dialog,
through which you create a response to
the sender of the message and the other
recipients, which includes a copy of the
message and any earlier messages in the
thread.

Forward Open the 'Model Message' dialog,
through which you forward the message
to other project team members with, if
necessary, your own comments.

Mark as
Unread

Mark the selected messages as unread.

Mark as Read Mark the selected messages as read.

Viewing
Panel

Adds a panel to the Model Mail view
showing the contents of the currently
selected message. The 'Viewing' panel
can be displayed to the right or bottom of
the message list. Select 'Hide' to show
only the message list.

(c) Sparx Systems 2018 Page 185 of 260



User Guide - Team Support 21 December, 2018

Help
Contents

Display this Help topic.

Model Mail Context menu options

Option Action

Compose
New
Message

Click to open the 'Model Message' dialog,
through which you create and send a mail
message.

Reply Create a response to the sender of the
message, which includes a copy of the
message and any earlier messages in the
thread.
Shortcut: Ctrl+R

Reply to All Create a response to the sender of the
message and the other recipients, which
includes a copy of the message and any
earlier messages in the thread.
Shortcut: Ctrl+Shift+R

Forward Forward the message to other project
team members with, if necessary, your
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own comments.
Shortcut: Ctrl+F

Set Message
Flag

Select the appropriate flag color to
establish the significance of the message
(the meanings of the flag colors should be
defined within the project team).

Mark as
Unread

Mark the selected messages as unread.
Shortcut: Ctrl+U

Mark as Read Mark the selected messages as read.
Shortcut: Ctrl+Q, or click on the message
and press the R key.

Delete Delete a selected message or messages;
you are prompted to confirm the deletion.

Manage your sent messages on the Sent
Items tab

Option Action

Open a
message

Double-click on the message.
From the open message you can reply to
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the sender, reply to the sender and all
other recipients, or forward the message
to other team members.

Flag Check the flag color to establish the
significance of the message (the
meanings of the flag colors should be
defined within the project team).

To Check the name(s) of the project team
member(s) to whom the message was
sent.

Subject The topic of the message.

Date Indicates the age of the message, whether
it was sent:

Today·

Yesterday·

This week·

Last Week·

This Month·

Last Month·

Older·

Sent The exact date and time the message was
sent.
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Select
Columns

Right-click on the column headings and
select the 'Field Chooser' menu option,
which enables you to add or remove
specific columns from the display.
You can also click on the column
headings and drag them across the header
bar to reposition the columns in a
different sequence.
Adding the 'Sender' column is useful to
identify whether you have sent the
message as an individual, or as a member
of a shared mail group.

Reorganize
messages in
the list

Either:
Click on a column heading to toggle·

sorting of list items by this column in
ascending or descending order, or
Right-click on the column heading and·

select the 'Enable Group Box' option to
organize the messages into groups

Delete
messages

Right-click on the message and select the
'Delete' option.
You are prompted to confirm the
deletion.

Reply to All Right-click on the message and select the
'Reply to All' context menu option.
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The 'Model Message' dialog displays.

Forward Right-click on the message and select the
'Forward' option.
The 'Model Message' dialog displays.
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Create a Message

You can use the 'Model Message' dialog to compose
messages to project team members within the project, under
your Author ID, and to:

Reply to messages from other team members·

Forward messages to other team members·

Link model components to the message, or add hyperlinks·

to files or other objects of relevance

Access

Context
Menu

Right-click on an object (or select several
objects) | Collaborate | Send Message

Ribbon Start > Collaborate > Mail

Create a message to another project team
member as a new message, a reply to a
message, or a forwarded message

Ste Action
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p

1 If you have selected the context menu 'Send
Message' option on one or more objects in the
Project Browser, the 'Model Message' dialog
immediately displays with links to each selected
object. The recipient of the message will be able to
press Ctrl and click on each link to open the
'Properties' dialog for the corresponding object.

2 Otherwise, the Model Mail view displays at the 'Mail
Inbox' tab. Select the appropriate toolbar icon or
context menu option to create or open and reply to or
forward a message.
The 'Model Message' dialog displays.

3 If you are creating or forwarding a message, or you
want to send a reply to a wider audience, for each
person you intend to send the message to:

Click on the To: button·

A list of project team member and group IDs
displays
Scroll to the required name and double-click on it·

The name is added to the 'To:' field

4 In the 'Subject' field, type or edit the subject of the
message as necessary.

5 In the 'Flag' field click on the drop-down arrow and
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on the appropriate flag color or option for your
message.

6 In the text panel, write the text of your message.
You can format the text using the facilities of the
'Notes' toolbar at the top of the field.

7 If you intend to link a (further) diagram or model
object to this message, place the cursor at the
appropriate position in your message text, click on
the object in the Project Browser, and click on the
Insert Quick Link button.
A short menu displays, listing the name of the object
you have selected or 'Other' to search for and select
another object. To link to the object you selected,
click on its name; a hyperlink to that object is
inserted in the message text.

8 If you intend to link to some other object, or you
want to link to another target such as a file, Model
Search or Team Library message, click on either:

The 'Hyperlink' icon in the toolbar or·

The Insert Quick Link button and select the 'Other'·

option
The 'Hyperlink Details' dialog displays; create the
required link.

9 Click on the Send button to send the message to the
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recipients.

Notes

This facility is available in the Corporate, Unified and·

Ultimate editions of Enterprise Architect, with User
Security enabled (Security provides the user names to
address your mail message to)
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Team Library

If the project team members require a forum in which to
discuss the development and progress of the project, they
can make use of the facilities of the Enterprise Architect
Team Library.

Access

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Features

Feature Description

Structure A point of discussion and the responses
(Comments) to that point are created as
Documents. Documents are held in Topic
groups, which are in turn organized into
Categories; your organization decides on
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the grouping and organization of
Documents.
You can create text to explain Categories
and Topics, and you can create and
respond to Documents and Comments on
Documents.

Displays The Team Library has two main displays:
The Team Library window is used to·

create new Categories and Topics and
to delete messages; you operate on it
by selecting options from the context
menu
Each item in the hierarchy displays a
mouse-over tool-tip, showing the item
title, the author's name and the date and
time the item was created
The 'Team Document' tab, in the main·

work area, is used to create, view, edit,
print, and comment on Documents, and
to create and maintain the descriptions
of Topics and Categories
This tab has a status bar that shows the
item author's name, the date and time
the item was created, and the date and
time the item was last modified

Facilities Within the Team Library you can:
Select to display and edit an item in the·
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'Team Document' tab, by clicking on
the item name in the Team Library
window
Search for text strings in the item titles·

to locate Documents on a specific
subject, using the 'Search' icon in the
toolbar of the Team Library window
Add resources to a Category, Topic or·

Document, such as diagram images and
XMI files of Packages; these are held
in a Resources folder under the selected
Team Library item
Link model elements, diagrams,·

external files and other Documents to a
Document
Link to a Team Library Document·

from the Linked Document on an
element
Change the loading behavior of the·

Team Library
Access Team Libraries from other·

projects, including those on other
servers

Specification
Manager

The Team Library acts as a repository for
the review documents generated in the
Specification Manager. These documents
are automatically stored in Topics within
the Formal Reviews Category, but you
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can redirect documents to a different
Topic from the Team Library, using the
'Bind to Project Browser Package' option.

Icons Each item in the Team Library window
has an icon that indicates the nature or
status of the item. The meaning of each
of these icons is explained here:

 - Document name·

 - Comment name·

 - Protected by password (also on·

Category and Topic icons); a blue icon
indicates that a user with the password
has opened the item, and a red icon
indicates that the item is locked

 - Status 'Awaiting Approval' (also on·

Category and Topic icons)
 - Status 'Approved' (also on·

Category and Topic icons)
 - Status 'Rejected' (also on Category·

and Topic icons)
 - Category name·

 - Topic name·

 - Resources folder for a Category,·

Topic or Document
 - Linked objects folder for a·

Category, Topic or Document
 - Diagram or clipboard image within·
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the Resources folder
 - XMI file of a Package, within the·

Resources folder

Notes

You can transport your Team Library set-up between·

projects, using the 'Configure > Model > Transfer >
Export Reference Data' and 'Import Reference Data'
ribbon options
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Work on Team Library Items

Within the Team Library, you can perform a wide range of
operations on the Documents and the Topics and Categories
that contain them. These operations include creating an
item, commenting on a Document, password-protecting an
item so that it is not accidentally changed, accessing
protected items, adding resources to an item, and deleting an
item. All of these operations are accessed through the
context menu in the Team Library window.

Access

Open the Team Library window using one of the methods
described here, then right-click on an item

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Team Library Options

Option Action
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New
Category
New Topic
New
Document

Add a new Category, new Topic or new
Document to the Team Library.
Alternatively, click on the 'New Topic' or
'New Document' icon in the window
toolbar.

New
Category
From
Template
New Topic
From
Template
New
Document
from
Template

Add a new Category, new Topic or new
Document, based on a defined template.

New
Comment

Create a response to the selected
Document.
Alternatively, click on the 'New
Comment' icon in the window toolbar.

Rename Edit the name of the currently-selected
item, in situ.
Shortcut: F2
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Copy Path to
Clipboard

Copy the path of the currently-selected
item to the clipboard.
You can then paste the path into a
document or file to add the discussion to
any text concerning the item.
Shortcut: Ctrl+C

Show
Contents

Display the description or text of the item
selected from the Team Library window,
if the 'Team Document' tab is not yet
open.

Share
Resource

(If anything other than a Resources folder
is selected.)
Add an item into the Resources folder
under the selected Category, Topic or
Document. If a Resources folder does not
exist, one will be automatically created.
Available options:

Package from Current Model·

Image of Active Diagram·

Active Profiler Report·

Bookmark Active Website·

Image from Clipboard·

Add Package
From Current
Model

(If a Resources folder is selected.)
Export a Package as an XMI file from the
current model as a resource of the
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selected Category, Topic or Document.
You browse for and select the required
Package using the 'Select <item>' dialog.

Import to
Current
Model

(If a Package XMI file resource is
selected.)
Import the resource Package to the
current model.
You browse for and select the required
target Package using the 'Select <item>'
dialog; the resource is imported as a child
of that Package.
This is a useful option for transferring
relevant Packages from the Team Library
of one model into another model.

Image of
Active
Diagram

(If a Resources folder is selected.)
Add an image of the currently-displayed
diagram as a resource of the selected
Category, Topic or Document.
You are prompted to provide a reference
name for this image.

Active
Profiler
Report

(If a Resources folder is selected.)
Add an active Profiler Report as a
resource of the selected Category, Topic
or Document.
You are prompted to browse for and
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select the appropriate active report.

Image From
Clipboard

(If a Resources folder is selected.)
Add an image held on the clipboard as a
resource of the selected Category, Topic
or Document.

View Image (If a diagram image resource is selected.)
Open the View Image window,
containing an image of the selected
diagram.
Alternatively, double-click on the image
name.

Copy Image
To Clipboard

(If an image resource is selected.)
Copy the image or diagram image to the
clipboard.

Refresh
Category
'xyz'
Refresh
Topic 'xyz'
Refresh
Document
'xyz'
Refresh
Comment

Refresh the currently-open Category,
Topic, Document or Comment, getting
new Comments, Documents and Topics
that other users might have created.
However, if you open a different
Category, Topic or Document the Team
Library always displays the latest
information from the database.
Alternatively, click on the 'Refresh' icon
in the window toolbar.
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'xyz'

Reload
Current
Connection

Reload the entire Team Library
connection, getting new Categories,
Topics and Documents.

Review
Status

Assign or clear a status marker against
the selected Category, Topic or
Document; you can mark the item as:

Awaiting Approval·

Approved·

Rejected·

Or clear the marker (None).

Bind to
Project
Browser
Package

Bind the selected Topic to a Package in
the Project Browser, so that Review
Documents created in the Specification
Manager for that Package are
automatically stored in the Topic.
When you select this option, the 'Select
Package to Bind' dialog displays, on
which you browse for and select the
Package to bind the Topic to.

Security
Options

Access one of three options:
'Apply Password Lock' - to display a·

prompt to enter a security password
'Unlock for Editing' - to display a·
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prompt to enter the set password so that
you can edit the item
'Remove Password Lock' - to display a·

prompt for the set password, which is
then removed

When you set the password, an
exclamation mark icon is added to the
Category, Topic or Document name.

Connections..
.

Access other Team Libraries from other
Enterprise Architect models or models
located on servers.
Alternatively, click on the drop-down
arrow in the 'Connection Options' field in
the window toolbar, and select one of the
listed models.
Use the '<Configure Connections>'
option to add and connect to additional
Team Libraries.

Options... Change the loading behavior of the Team
Library.

Delete
Category
'xyz'
Delete Topic
'xyz'

Delete this Category, Topic, Document or
Comment and all sub-topics and
sub-documents, or delete the resource
attached to the item.
Alternatively, click on the item and press
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Delete
Document
'xyz'
Delete
Resource
'xyz'
Delete
Comment
'xyz'

the Delete key.
A confirmation dialog displays; click on
the Yes button to remove the item and
any dependent items from the Team
Library.
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Add a New Category

You can add new Categories to the Team Library, in which
to store related Topics and Documents.

Access

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Create a Category

Ste
p

Action

1 Right-click on a blank area in the Team Library
window and select the 'New Category' option.
A new 'Category' icon displays in the hierarchy.
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2 Overtype the New Category text with the name of
the Category, and click off the name.
The Category description editor displays in the
'Team Document' tab; type the appropriate Category
description, if required.

3 Add new Topics and/or resources to the Category.

Create a Category - Alternative

Ste
p

Action

1 Right-click on a blank area in the Team Library
window and select the 'New Category from template'
option.
A new 'Category' icon displays in the hierarchy.

2 Overtype the New Category text with the name of
the Category, and click off the name.
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The 'New Category from Template' dialog displays.

3 Click on the 'Template' drop-down arrow and select
a predefined template for the Category description.
Click on the OK button.

4 The Category description editor displays in the
'Team Document' tab; type the appropriate Category
description, if required.

5 Add new Topics and/or resources to the Category.
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Add a New Topic

In the Team Library you can add new Topics to a Category,
in which to store related Documents and their Comments.

Access

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Create a new Topic

Ste
p

Action

1 Either:
Right-click on the required Category name in the·

Team Library window and select the 'New Topic'
option
Click on the Category name and click on the 'New·

Topic' icon in the Team Library toolbar, or
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Click on the Category name and press Ctrl+N·

A new 'Topic' icon displays under the Category
name.

2 Overtype the New Topic text with the name of the
Topic, and click off the name.
The Topic description editor displays in the 'Team
Document' tab; type the appropriate Topic
description, if required.

3 Add new Documents and/or resources to the Topic.

Create a new Topic - Alternative

Ste
p

Action

1 Right-click on the required Category name in the
Team Library window and select the 'New Topic
from Template' option.
A new 'Topic' icon displays under the Category
name.

2 Overtype the New Topic text with the name of the
Topic, and click off the name.
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The 'New Topic from Template' dialog displays.

3 Click on the 'Template' drop-down arrow and select
a predefined template for the Topic description.
Click on the OK button.

4 The Topic description editor displays in the 'Team
Document' tab; type the appropriate Topic
description, if required.

5 Add new Documents and/or resources to the Topic.

Notes

If you already have the 'Team Document' tab open, the·

'New Topic from Template' dialog displays as soon as you
select the 'New Topic from Template' menu option; you
can click on and overtype the Topic name after you have
created the Topic description
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Add a New Document

Within the Team Library, you can create a new Document
on a Topic as either:

A blank Document·

A Document based on a predefined template, or·

A Document from a file link·

Access

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Create a blank Document

Ste
p

Action

1 Either:
Right-click on the appropriate Topic name in the·
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Team Library window and select the 'New
Document' option
Click on the Topic name and on the 'New·

Document' icon in the Team Library toolbar, or
Click on the Topic name and press Ctrl+N·

A new 'Document' icon displays underneath the
Topic name.

2 Overtype the New Document text with the name of
the Document, and click off the name.
The text editor displays in the 'Team Document' tab.

3 Type the text of the Document as required.

Create a Document based on a predefined
template

Ste
p

Action

1 Right-click on the appropriate Topic name in the
Team Library window and select the 'New
Document from template' option.
A new 'Document' icon displays in the hierarchy.
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2 Overtype the New Document text with the name of
the Document, and click off the name.
The 'New Document from Template' dialog displays.

3 Click on the drop-down arrow in the 'Template' field,
and select a predefined template for the Document
contents.

4 Click on the OK button.
The template structure is displayed in the 'Team
Document' tab.

5 Type in or paste the text of the Document.

Create a Document based on a link to an
external file

Ste
p

Action

1 Open a file browser (such as Windows Explorer) and
locate the file.

2 Click on the file name and drag it onto the
appropriate Topic name in the Team Library
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window.
A new 'Document' icon is created underneath the
selected Topic, and the body of the Document is
shown in the 'Team Document' tab.
A link to the source file is created at the start of the
message.

3 Click twice on the New Document text in the Team
Library window, and overtype the text with the name
of the Document.

4 In the 'Team Document' tab, create and edit text
around the file link, and add further links if required.

When you have created the Document

You can Detail

Create links
from the
Document

To elements and diagrams from the:
Project Browser·

Model Search·

Model Views window, or·

Package Browser·

Create links Such as:
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from the
Document to
Team Library
objects

Categories·

Topics, and·

Documents·

Create links
from the
Document to
external files

These links can be either in the text of the
Document or on the Category, Topic or
Document in the Team Library window
(the link is added to the Model Links
folder for the Team Library item).

Add
resources to
the
Document

It is simple and convenient to link to the
resources that are the subject of
discussion or that illustrate points in the
discussion.

Receive
Comments
on the
Document
from other
users

The objective of the Team Library is to
discuss aspects of development, so you
can expect to receive Comments on the
Documents that you have posted, and to
create Comments on the material posted
by your colleagues.
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Comment on a Document

You use the Team Library as a forum for discussion of
items and issues within the project, so when you read a
Document on a particular point (or a response to that
Document) you might want to respond with your own
Comment.

You can create a Comment directly from the Document you
are responding to, from material that you want to use as
your response, or from a predefined document template.

Access

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Create a Comment in the Team Library

Ste
p

Action
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1 Either:
Right-click on the required Document (or·

Comment) in the Team Library window and select
the 'New Comment' option
Click on the Document name and on the 'New·

Comment' icon in the Team Library toolbar, or
Click on the Document name and press Ctrl+N·

A Re:<Documentname> entry displays underneath
the Document you are replying to, and the cursor
becomes active in the 'Team Library ' tab so that you
can create and edit your response.

2 Type in, format and save the contents of the
Comment.

Create a Comment from external material

Ste
p

Action

1 Open a file browser (such as Windows Explorer) and
locate a file containing the material you want to use
in your response.

2 Click on the file name and drag it into the Team
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Library window, over the Document to which you
are replying.
A prompt displays for you to specify whether to:

Create a new Comment containing the text of the·

file (the file name displays as the Comment name)
or
Add the file to the original Document as a Model·

Link

3 If necessary, edit, format and save the contents of the
reply.

Create a Comment based on a predefined
template

Ste
p

Action

1 Right-click on the appropriate Document name in
the Team Library window and select the 'New
Comment from template' option.
A new 'Comment' icon displays in the hierarchy, and
the 'New Document from Template' dialog displays.

2 Click on the drop-down arrow in the 'Template' field,
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and select a predefined template for the 'Comment'
contents.

3 Click on the OK button.
The template structure is displayed in the 'Team
Library' tab.

4 Type in or paste the text of the Document.

When you have created the Comment

You can Detail

Create links
from the
Comment

To elements and diagrams from the:
Project Browser·

Model Search·

Model Views window, or·

Package Browser·

Create links
from the
Comment to
Team Library
objects

These links can be to related Team
Libraries:

Categories·

Topics and·

Documents·
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Create links
from the
Comment to
external files

These links can be either in the text of the
Comment or on the parent Category,
Topic or Document in the Team Library
window (the link is added to the Model
Links folder for the Team Library item).

Add
resources to
the Comment

It is simple and convenient to link to the
resources that are the subject of
discussion or that illustrate points in the
discussion.

Receive
replies to the
Comment
from other
users

The objective of the Team Library is to
discuss aspects of development, so you
can expect to receive replies to the
Comments that you have posted, and to
create Comments on the material posted
by your colleagues.
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Protection Against Editing

When you have created a Team Library Category, Topic or
Document containing text, the item text is exposed to
change by any user who has access to the Team Library.
You can protect the item against unrestricted changes by
setting a password on it. The password only refers to that
item; to protect the text of Topics, Documents or Comments
subordinate to the item, you set a password on each of them
as well.

When the password is set, only those users who have the
password can edit that item, and only when they specifically
enter the password to unlock that item. Any other user of the
Team Library can still view the protected item.

The password does not protect the item from operations on
the item as a whole, including being deleted.

Notes

The use of a password on an item is indicated by an·

exclamation mark against the item in the Team Library
window; a blue icon indicates that a user with the
password has opened the item, and a red icon indicates
that the item is locked

When you click on an item to set a password, the item·

opens; you can edit the item after you have set the
password, while it is still open
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Once a password-protected item is closed, any user who·

wants to edit the item must first select to unlock the item
for editing and then enter the password set on the item

Unlocking is specific to the user; the item remains locked·

to other users until they enter the password themselves

If the password becomes unnecessary, you can remove it·

from the item
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Edit an Item

When you have created a Category, Topic, Document or
Comment, you edit the text within it using the Team
Document editor. This is based on the Document editor,
which is used to edit report documents and Linked
Documents throughout Enterprise Architect.

You can also change the name of the item by selecting it,
pressing F2 and typing the new name.

Access

Open the Team Library window using one of the methods
outlined here, then double-click an item or select the item
and press the Enter key, to open the Team Document editor.

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Option Descriptions

The editor menu option descriptions are grouped according
to the actions you are performing.
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Actions

Creating and importing documents

Configuring the editor page display and formatting tools
shown

Incorporating stylesheets, special texts and Tables of
Contents
Managing the base styles in the Normal.rtf style template
file

Moving through, searching and selecting text

Formatting characters and text strings

Formatting paragraphs and text blocks

Inserting tab points

Inserting sections, columns and page breaks, and
repaginating

Inserting and editing page headers and footers, and
footnotes and endnotes

Inserting tables
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Inserting hyperlinks and bookmarks (including using the
'New', 'Link to Existing Element' and 'Hyperlink' options
on the 'Create' context menu)

Inserting images, OLE objects, frames and drawing
objects

Printer set up and printing documents

Check spelling and use of terms

Tracking, accepting and rejecting changes to the text

Protecting document text from accidental change

Create and refer to definitions of Glossary terms in the
Project Glossary (using the 'Create | Glossary Definition'
context menu option)

Notes

To undo one or more immediately previous edits, press·

Ctrl+Z, or select the 'Layout > Undo > Undo' ribbon
option; you can still undo a change even after you have
saved the change

To redo one or more immediately previous undone edits,·
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press Ctrl+Y, or select the 'Layout > Undo > Redo' ribbon
option
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Add Object Links

In the Team Library window you can create hyperlinks from
a Document to any elements and diagrams that are
associated with it. This helps you to:

Rapidly navigate to the objects in the Project Browser·

Access the element properties, and·

Open a diagram directly from the Team Library·

You can also create links to:

Other Categories, Topics and Documents in the Team·

Library window

External files from a file browser·

Facilities

Facility Action

Associate an
element,
diagram,
external file
or Team
Library item
with a
message

Drag the object over the required
Category, Topic or Document in the
Team Library window, from the:

Project Browser·

Package Browser·

Model Views window·

Model Search window or·

External file browser·
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To create a link to another Team Library
item, press Ctrl as you drag that item over
the required Category, Topic or
Document.
If it does not already exist, a Model Links
folder is created under the selected Team
Library item, and the link to the dragged
object is added to the folder.

Associate an
external file
with the
message text

From any browser, click on and drag the
file name into the text of the message.
The filename becomes a link to the file;
click on it to display the contents of the
file.
The external file name also becomes a
link to the file within the message when
you drag the filename onto a Topic to
create a Document.

Review Options

To review an object in the Model Links folder, right-click on
the object to display the navigation context menu.

Option Action

Open Open the linked diagram or external file.
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Alternatively, double-click on the
diagram link.

Properties Display the 'Properties' dialog for the
selected element or diagram.
Alternatively, double-click on the
element, attribute or operation link to
open the 'Properties' dialog of the object.

Create (Edit)
Linked
Document

Either:
Open the 'New Linked Document from·

Template' dialog, to begin creating a
new Linked Document on the element,
or
Open the 'Linked Document Editor' to·

change an existing Linked Document

Find in all
Diagrams

Open the diagram in which the element is
used, or display a list of several diagrams
in which the element has been used.

Find in
Project
Browser

Highlight the element or diagram in the
Project Browser.

Locate Item Highlight, in the Team Library window,
the Team Library item linked to the
message.
Alternatively, double-click on the link in
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the Model Links folder.

Delete Model
Link <name>

Delete the association between the
Document and the object.
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Team Library Resources

Whilst having a discussion through the Team Library, it is
convenient to link to the resources that are the subject of
discussion or that illustrate points in the discussion. Such
resources include:

XMI files of Packages within the current project·

Active Profiler reports·

Images of currently-active diagrams·

Images currently captured on the clipboard·

Bookmarks to currently active websites·

You can link to such resources from Category or Topic
notes, or from a Document. The resource links are created in
a Resources folder underneath the selected Category, Topic
or Document, as shown:

Access

Open the Team Library window using one of the methods
outlined here, then;

Right-click on <object> | Share Resource | <resource type>

You create the Resources folder by creating a link to a
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resource underneath the selected Category, Topic or
Document. Similarly, you delete the Resources folder by
deleting the last resource within it. Having added a resource,
you can right-click on it and use a further context menu to:

Reimport the Package XMI files to the model or·

Display the images·

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

(c) Sparx Systems 2018 Page 235 of 260



User Guide - Team Support 21 December, 2018

Search Team Library

The Team Library provides the facility to search the titles of
all Team Library items, to locate items referring to a
specific subject.

Search the Team Library

Ste
p

Action

1 In the Team Library window toolbar, click on the 
(Search) icon.
The search panel displays underneath the toolbar.

2 In the blank field, type the text string to search for.

3 If required, select the 'Match Case' checkbox to
locate text with the same case as the search string.

4 If required, select the 'Match Whole Word' checkbox
to locate only complete words that match the search
string.

5 Click on the Find button.
The search locates the first instance of the search
string in the title of a Category, Topic, Document or
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Comment, and displays the contents of that item in
the 'Team Library' tab.

6 To locate further instances of the text string, click
again on the Find button.

7 To close the search panel, click again on the 'Search'
icon in the toolbar.
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Team Library Options

You can change the loading behavior of the Team Library,
using the 'Team Library Server Options' dialog. If you
change the settings, the new loading behavior is not applied
until you restart the Team Library.

Access

Open the Team Documents window using one of the
methods outlined here, then right-click in the Team
Documents window and select 'Options'.

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Team Library Options

Option Action

Preload items
less than

Type the threshold item size (in KB)
below which the items will be preloaded
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and above which item data is only loaded
when selected.

Load item
data when
required

The fastest loading option. Team Library
data is only loaded on demand; for
example, when you read a Document.

Preload all
data

Caches the entire contents of the Team
Library on load; this takes longer to load
but, once completed, navigating the Team
Library is faster.
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Team Library Connections

If you are modeling in a different model from the rest of
your team, you can switch to Team Libraries from other
Enterprise Architect models, including models located on
servers. This connects only to the Team Library for the
selected model; it does not change the model open in the
Project Browser or anywhere else in the system.

Access

Open the Team Documents window using one of the
methods outlined here, then either:

Right-click on the Team Documents window and select·

'Connections', or

Click on the 'Connection Options' drop-down field and·

choose 'Configure Connections'

Ribbon Start > Collaborate > Team Library

Keyboard
Shortcuts

Ctrl+Alt+U

Switch to another Team Library
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Ste
p

Action

1 Select the appropriate model name from the
drop-down list in the '<current model>' field, to
connect to the Team Library for that model.
If the required model is not listed, click on the
'<Configure Connections>' option; the 'Team
Documents Server Connections' dialog displays.

Go to Step 3.

2 Alternatively:
Right-click anywhere in the Team Library window
and select the 'Connections' option; the 'Team
Documents Server Connections' dialog displays.
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In the list in the 'Connections' panel, select the
checkbox against the appropriate model name to
connect to the Team Library for that model, then
click on the Open button.
The connection now switches to the Team Library in
the selected model.
If the required model is not listed, go to Step 3.

3 Click on the New button and select the appropriate
type of connection from the list.

For a local project file, a browser dialog displays·

through which you can search for and select the
appropriate model
For a model in a DBMS data repository, select the·

'Connection Wizard' option to display the
Microsoft 'Data Link Properties' dialogs, through
which you can locate and connect to the repository
For a Cloud connection, the 'Cloud Connection'·

dialog displays in which you specify the details of
the model connection on the Cloud
For an external connection string, a prompt·

displays in which you type in or paste that
connection string

4 When you have selected and opened or connected to
the required Enterprise Architect model, and
returned to the 'Team Documents Server
Connections' dialog, the model name displays in the
'Connection Name' field and in the 'Connections'
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panel.

5 Select the checkbox against the model name and
click on the Open button to connect to the Team
Library for that model.
The Team Library now shows the discussions in the
selected model.

Fields/Options on the 'Team Documents
Server Connections' dialog

Option Action

Connection Verify the name of the selected model.

Target Verify the path to the selected model.

New Click on this button to display the list of
connection types you can select as the
first step in identifying the model for a
new Team Library connection.

Delete Click on this button to delete the
currently selected connection from the
'Connections' list. There is no
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confirmation prompt; the connection is
immediately removed from the list.

Connections View all Team Library connections
created; click on the checkbox against the
required connection.

Open Click on this button to switch the Team
Library to the selected connection and to
close the dialog.
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Spell Checking

Enterprise Architect provides a powerful spell checking
facility. This operates at both project level and Package
level.

Topics

Topic Detail

Automatic
Spell
Checking

The spell checker can be set to run
automatically, so that it highlights
possible errors in text as it is created or
pasted in:

Select 'Start > View > Preferences >·

Objects'
Deselect or select the 'Disable spelling'·

checkbox

Spelling
Configuratio
n

You can configure what types of text
error the spell checker should detect,
using the 'Spelling Options' dialog.

Using Enterprise Architect is supplied with
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Languages
Other Than
English

dictionaries for US English, Canadian
English and British English; you can
download a set of dictionaries for other
languages from the Sparx Systems
website.

Using the
Spell
Checker

You can run the spell checker manually
on the whole model, or on a selected
Package.

Correcting
Text

As the spell check progresses, Enterprise
Architect highlights any errors or
unknown words; you have several
options for responding to these potential
spelling errors.

Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Spell Check' permission to perform any spell check or
change any spell check options
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Select Spell Checker Options

You can configure the spell checker to ignore or detect
specific types of text conformation. Ignoring the
conformation means to skip over the text without identifying
it as an error.

Access

Ribbon Publish > Tools > Spelling > Spelling
Options

Configure the spell checker

Option Action

Ignore
capitalized
words

Ignore any words beginning with a
capital letter, such as 'David'.
You might enable this option if the text
being checked contains many proper
names.

Ignore Ignore any words containing all capital
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all-caps
words

letters, such as RADAR.
You might enable this option if the text
being checked contains many acronyms.

Ignore Words
with
Numbers

Ignore any words containing embedded
digits, such as 'Win95' and 'Q4'.
You might enable this option if the text
being checked contains many code words
or other symbols containing digits.

Ignore Words
with Mixed
Case

Ignore any words containing an unusual
mixture of upper- and lower-case letters,
such as 'MicroHouse' and 'CapsLock'.
You might enable this option if the text
being checked contains many variable
names or other symbols that use changes
in letter-case to distinguish words.

Ignore
Domain
Names

Ignore any words that appear to be
Internet domain names, such as
wintertree-software.com.

Report
Doubled
Words

Detect any word appearing twice in a
row, such as 'the the'.

Case
Sensitive

Distinguish between capitalized and
non-capitalized words.
For example, canada would be considered
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as different from Canada, and therefore
reported as a misspelling.
When the option is disabled, canada and
Canada are considered to be identical.
Note that the performance of the spell
checker is reduced if this option is
disabled.

Phonetic
Suggestions

Suggest alternative words based on
phonetic (sounds-like) similarity to the
misspelled word; this option tends to
improve the correction of badly
misspelled words.
Enabling this option increases the time
required to locate suggestions.
Note that either this option or the
'Typographical Suggestions' option must
be enabled in order to list suggestions of
alternative words.

Typographica
l Suggestions

Suggest alternative words based on
typographical (looks-like) similarity to
the misspelled word. This option is
appropriate for people who are generally
good spellers.
Note that either this option or the
'Phonetic Suggestions' option must be
enabled in order to list suggestions of
alternative words.
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Suggest Split
Words

Suggest two separate words as a
replacement for a misspelling containing
two joined words.
For example, is the would be suggested
as a replacement for isthe.

Auto Correct Automatically change words marked with
Auto Change actions to their specified
replacements.
When this option is disabled, a
confirmation prompt displays before the
words are changed.

Main
Dictionary
Language

Set the language of the main dictionary
used to check spelling; the drop-down list
shows only languages for which
dictionaries are installed on your system.
To check spelling in a different language,
select the language in the list.

Suggestions Determine the speed and accuracy of the
initial automatic search for suggested
replacements for misspelled words.
Click on the appropriate radio button for
your choice.

OK Close the 'Preferences' dialog, and save
any changes made to the settings.
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Cancel Close the ''Preferences' dialog, and
discard any changes made to the settings.

Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Spell Check' permission to perform any spell check or
change any spell check options
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Use Languages Other Than English

Enterprise Architect is supplied with three dictionaries, for
US English, Canadian English and British English.
Additional dictionaries are available as a pack, for download
from the registered pages of the Sparx Systems website.

The dictionaries in this downloadable file enable spell
checking in these languages:

Brazilian·

Danish·

Dutch·

Finnish·

French (Continental)·

German·

Italian·

Norwegian·

Portuguese·

Spanish and·

Swedish·

Download the additional language dictionary
pack

Ste
p

Action
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1 Access the registered user page on the Sparx
Systems web site.

2 At the end of the page, download the EADict.zip file
from the Enterprise Architect Dictionary section.

3 Unzip the file into the Enterprise Architect install
directory - C:\Program Files\Sparx Systems\EA.
This makes the non-English spelling dictionaries
available to the Enterprise Architect spell checker.

Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Spell Check' permission to perform any spell check or
change any spell check options

Enterprise Architect .EAP files default to use Jet 3.5 as·

the database engine; this does not support unicode
character sets, which makes the use of certain languages -
such as Portuguese - difficult, including spell checking
words in those languages

If you use such languages, it is recommended that you
either upsize to a DBMS repository or set JET 4.0 as the
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database engine

If your .EAP project is not in a Jet 4.0 database, you
should also download a copy of the Jet 4.0 EABase model
from the Sparx Systems website, and do an EAP to EAP
transfer of your model into the Jet 4.0 file
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Using the Spell Checker

Enterprise Architect has an inbuilt spell checker, which you
can configure to detect a range of types of possible spelling
error in your project, and to use one of several language
dictionaries other than English.

Access

Ribbon Publish > Tools > Spelling > Spell Check
Project
Publish > Tools > Spelling > Spell Check
Current Package

Keyboard
Shortcuts

Ctrl+F7            (spell check project)
Ctrl+Shift+F7        (spell check current
Package)

Run the spell checker

Ste
p

Action
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1 Select the 'Spell Check Project' or 'Spell Check
Current Package' menu option, as required.
The 'Spell Check' dialog displays.

2 ('Spell Check Project' option.) Select the checkbox
against each of the items to spell check within your
model.

3 Click on the Start button to begin the spell check.
As the spell check proceeds, the text being checked
displays in the text panel at the bottom of the screen;
if an error is detected, the 'Check Spelling' dialog
displays, offering several options to correct the error.

Notes

You can use the 'Spell Check Project' menu option to·

check spelling for the entire project

The 'Spell Check Current Package' option only checks the·

Package currently open, and you cannot select items to
check

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Spell Check' permission to perform any spell check or
change any spell check options
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Correcting Words

As a spell check progresses, Enterprise Architect highlights
any errors or unknown words in the 'Check Spelling' dialog.
The inbuilt spell check stores user-defined words in the user
dictionary (%APPDATA%\Sparx Systems\EA\userdic.tlx).
During the spell check process, if you add a word, it is
written into this file for later reference. While the spell
check is in progress you can:

Correct the spelling of a word·

Ignore the error·

Add the word to the user dictionary·

Suggest alternatives or·

Otherwise assist in the spelling correction process·

Correct spelling

As the Spell Checker identifies possibly mis-spelled words,
make the appropriate response:

Action

Modify the spelling by hand and click on the Change or·

Change All button to change the word to that spelling
Click on a suggested alternative and click on the·

Change or Change All button to change the word to that
spelling
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Click on the Ignore or Ignore All button to exclude the·

word from the spell check
Click on the Add button to add the word to the user·

dictionary
Click on the Suggest button to list alternative spellings·

or words
Click on the Cancel button to abort the spell check·

entirely

(c) Sparx Systems 2018 Page 259 of 260



User Guide - Team Support 21 December, 2018

(c) Sparx Systems 2018 Page 260 of 260


	Team Support
	Project Roles
	Summary of Typical Tasks
	Business Analysts
	Software Architects
	Software Engineers
	Developers
	Project Managers
	Testers
	Implementation Managers
	Technology Developers
	Database Developers

	Formal Review Elements
	Informal Discussions

	Model Chat
	Introducing the Journal
	User Security
	Enable/Disable Security
	Set Security Policy
	Maintain Groups
	Maintain Users
	Single Sign-On (SSO)
	Single Sign-On (SSO) Options
	Configure OpenID

	Import User IDs From Active Directory
	List of Available Permissions
	View All User Permissions
	View and Manage Locks
	Password Encryption
	Change Password
	Lock Model Elements
	Lock Objects Under User/Group Locking
	Lock Packages Under User/Group Locking
	Lock Objects Under Require User Lock to Edit

	Locked Element Indicators
	Identify Who Has Locked An Object
	Manage Your Own Locks

	Project Calendar
	Calendar
	Configure Event Subtypes

	Allocated Resources
	Project Tasks

	Model Mail
	Create a Message

	Team Library
	Work on Team Library Items
	Add a New Category
	Add a New Topic
	Add a New Document
	Comment on a Document
	Protection Against Editing
	Edit an Item
	Add Object Links
	Team Library Resources
	Search Team Library
	Team Library Options
	Team Library Connections

	Spell Checking
	Select Spell Checker Options
	Use Languages Other Than English
	Using the Spell Checker
	Correcting Words




